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How to Use This Manual

This manual describes the role of the CS+ integrated development environment for developing applications and sys-
tems for RH850 family, RX family, and RL78 family, and provides an outline of its features.

CS+ is an integrated development environment (IDE) for RH850 family, RX family, and RL78 family, integrating the nec-
essary tools for the development phase of software (e.g. design, implementation, and debugging) into a single platform.

By providing an integrated environment, it is possible to perform all development using just this product, without the 
need to use many different tools separately.

Readers This manual is intended for users who wish to understand the functions of the CS+ and 
design software and hardware application systems.

Purpose This manual is intended to give users an understanding of the functions of the CS+ to use 
for reference in developing the hardware or software of systems using these devices.

Organization This manual can be broadly divided into the following units.

1.GENERAL
2.FUNCTIONS
A.WINDOW REFERENCE
B.REGULAR EXPRESSIONS SYNTAX

How to Read This Manual It is assumed that the readers of this manual have general knowledge of electricity, logic 
circuits, and microcontrollers.

Conventions Data significance: Higher digits on the left and lower digits on the right
Active low representation: XXX (overscore over pin or signal name)
Note: Footnote for item marked with Note in the text
Caution: Information requiring particular attention
Remarks: Supplementary information
Numeric representation: Decimal ... XXXX

Hexadecimal ... 0xXXXX
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1.  GENERAL

This chapter describes the overview of the editor features that CS+ provides. 

Caution When the E2 emulator Lite (abbreviated name: E2 Lite) is used, please read references to "E1" in this 
manual as also meaning "E2 Lite".
When the E2 emulator (abbreviated name: E2) is used, please read references to "E1" in this manual as 
also meaning "E2".
When the IE850A emulator is used, please read references to "E1" in this manual as also meaning 
"IE850A".

1.1  Summary

The editor features that CS+ provides are implemented by using the Editor panel.
In the Editor panel, the source file is displayed and can be edited.  Furthermore, the source level debugging/instruction 

level debugging and the display of the code coverage measurement resultNote can be performed in this panel. 

Note The code coverage measurement result is displayed only when the debug tool to be used supports the 
coverage function. 

Remark For details on the debugging process and main functions for debugging, see "CS+ Integrated Develop-
ment Environment User's Manual: Debug Tool".

Figure 1.1 Editor Panel in Main Window (When RH850 is Selected)

1.2  Features

The following are the editor features provided by CS+.

Caution C++ source files are only supported by CC-RX. 

- Display and editing of the contents of files
The contents of text files and C/C++ source files can be displayed/edited.

Editor panel
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- Support of the code outlining
For a C/C++ source file, this function allows you to expand and collapse source code blocks so that you can concen-
trate on the areas of code which you are currently modifying or debugging. 

- Mixed display of C/C++ source text and disassembled text
By connecting to the debug tool, the C/C++ source text and the disassembled text can be displayed together on the 
same panel.

- Source level debugging and instruction level debugging
By connecting to the debug tool, the C/C++ source file can be debugged either at the source or the instruction level.

- Display of the code coverage measurement result
By connecting to the debug tool that supports the coverage function, the code coverage measurement result can be 
displayed.
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2.  FUNCTIONS

This chapter describes the main functions of the Editor panel provided by CS+. 
For details on how to read each area and about their functionality, see the section in which the Editor panel is described.

2.1  Open the Editor Panel

You can open the Editor panel by any one of the following method. 
The Editor panel can be opened multiple times (max. 100 panels).

Caution 1. When a project is closed, all of the Editor panels displaying a file being registered in the project are 
closed.

Caution 2. When a file is excluded from a project, the Editor panel displaying the file is closed.

(1) Double-click a file on the Project Tree panel
On the Project Tree panel, double-click a file shown in "Table 2.1Files That Can Be Opened in Editor Panel".

Caution When an external text editor is set to be used in the Option dialog box, the file is opened with the 
external text editor that has been set. 
Files other than below are opened with the applications associated by the host OS (a  file with the 
extension that is not associated with the host OS is not displayed).

Table 2.1 Files That Can Be Opened in Editor Panel

Type of File Extension

C source file *.c

C++ source file [CC-RX] *.cpp, *.cc, *.cp

Header file *.h, *.inc, *.hpp [CC-RX]

Assembly source file [CC-RH] *.asm, *.s, *.fsy

Assembler source file [CC-RX] *.src, *.s

SMS Assembly source file [CC-RL] *.smsasm

Link order specification file *.mtls

Link map file [CC-RH] *.map, *.lbp

Map file *.map, *.lbp [CC-RX]

Intel HEX file [CC-RH] *.hex

Hex file *.hex

Motorola S-record file [CC-RH] *.mot

S record file [CC-RX] *.mot

Assemble list file *.prn [CC-RH], *.lst [CC-RX]

Stack information file [CC-RH] *.sni

Jump table file [CC-RX] *.jmp

Symbol address file [CC-RX] *.fsy

Cross reference file [CC-RX] *.cref

Link subcommand file [CC-RX] *.clnk

Python script file *.py

Text file *.txt
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Figure 2.1 Open of File (When Disconnected from Debug Tool)

(1): Line number area
(2): Selection area
(3): Main area
(4): Characters area

(2) Download a load module file
Click the  button on the debug toolbar.
The Editor panel automatically opens with displaying the contents of the downloaded source file after a load mod-
ule file is successfully downloaded.

Remark For details on how to download, see "CS+ Integrated Development Environment User's Manual: 
Debug Tool".

Figure 2.2 Open of Source File (When Connected to Debug Tool)

Toolbar

(1)
(2)

(3) (4)

Toolbar

(1)
(2)(3)

(4) (5) (6) (7) (8)
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(1): Line number area
(2): Selection area
(3): Out of date module Indicator area
(4): Coverage area
(5): Address area
(6): Event area
(7): Main area
(8): Characters area

Remark 1. You can open a file with a specific encoding selected in the Encoding dialog box that is opened by 
selecting the [File] menu >> [Open with encoding...]. 

Remark 2. When a file whose size is greater than 24MB is opened, a message dialog box is shown for confir-
mation of whether or not to disable all of the functions listed below (if you select [No] in this mes-
sage dialog box, the operation speed may become sluggish).

- Syntax (reserved words, comments, etc.) coloring

- Code outlining function (see "2.4.5Use code outlining")

- Smart edit function (see "2.4.6Use the smart edit function")

2.2  Set the Columns to Display

The columns or marks displayed on the Editor panel can be set by selecting the toolbar items shown below. 
Note that this setting applies to all of the Editor panels.

2.3  Split the Panel

The Editor panel can be displayed in split form by using the vertical and horizontal splitter bars. The Editor panel can be 
split in up to two divisions vertically, and two divisions horizontally.

To remove the split, double-click any part of the splitter bar.

Columns The following items are displayed to show or hide the columns or marks on the 
Editor panels. 
Remove the check to hide the items (all the items are checked by default).

Line Number Shows the line number, in the line number area.

Selection Shows the mark that indicates the line modification status, in the line number area.

Out of date module indicator Shows the mark that indicates the update status of the downloaded load module 
file, in the line number area.
Note that this item is enabled only when connected to the debug tool. 

Coverage Shows the coverage area.
Note that this item is enabled only when connected to the debug tool. 

Address Shows the address area.
Note that this item is enabled only when connected to the debug tool. 

Op Code Shows the code area.
Note that this item is enabled only when connected to the debug tool and the 
Mixed display mode is selected.

Label Shows the label area.
Note that this item is enabled only when connected to the debug tool and the 
Mixed display mode is selected.

Event Shows the event area.
Note that this item is enabled only when connected to the debug tool. 

Main Shows the main area.

Column Header Shows the column header.
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Caution This function is disabled when the Mixed display mode is selected (setting to the mixed display mode 
removes the split).

Remark You can also split the panel by double-clicking any part of the splitter.

Figure 2.3 Splitter Bar

Figure 2.4 Vertical/Horizontal Two-way Split View

2.4  Edit Characters

In the character area, you can enter character strings from the keyboard.
Various shortcut keys can be used to enhance the edit function.
The following items can be customized by setting the Option dialog box.

- Display fonts

- Tab interval

- Enable/disable auto indentation

- Show/hide white space marks (blank symbols)

- Syntax coloring reserved words and comments

Caution Characters cannot be edited when the Mixed display mode is selected.

Splitter bar

Splitter bar

Splitter bar

Splitter bar
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2.4.1  Highlight the current line

By selecting the [Enable line highlight for current] check box in the [Text Editor - General / Debug] category of the Option 
dialog box, the current line (i.e. line at the current caret position) can be displayed within a rectangle (the rectangle color 
depends on the highlight color in the [General - Font and Color] category of the Option dialog box).

Figure 2.5 Highlighting Current Line

Remark The rectangle color depends on the highlight color in the [General - Font and Color] category of the 
Option dialog box.

2.4.2  Emphasize brackets

The bracket that corresponds to a bracket at the caret position is shown emphasized (default).
Supported types of brackets vary with the file type as follows.

Caution When CS+ emphasizes the corresponding bracket, it does not consider those within comments, charac-
ter constants, character strings, or string constants.  For this reason, if the bracket at the position of the 
caret is within a comment, character constant, character string, or string constant, CS+ may emphasize a 
bracket that is not actually the corresponding bracket.

Table 2.2 Supported Types of Brackets

2.4.3  Select characters

You can select multiple lines or a block that consists of multiple lines by any one of the following methods.
Editing of the selected contents can be done by using [Cut], [Copy], [Paste], or [Delete] from the [Edit] menu.

Caution The information of bookmarks (see "2.8Register Bookmarks") is not included in the selected contents.

(1) Multiple lines selection

- Drag the left-mouse button

- Press the [Right], [Left], [Up] or [Down] key while holding down the [Shift] key

(2) Block selection

- Drag the left-mouse button while holding down the [Alt] key

- Press the [Right], [Left], [Up] or [Down] key while holding down the [Alt] + [Shift] key

Figure 2.6 Multiple Lines Selection and Block Selection

Caution If you select a block and paste it on the last line, a new line will be added below the last line. Note that the 
block will be pasted from the beginning of the new line regardless of where you have tried to paste it 
within the last line.

File Type Types of Brackets

C/C++ source file ( and ), { and }, [ and ]

Python file

HTML file < and >

XML file

[Multiple lines selection] [Block selection]
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2.4.4  Search/replace characters

You can search for/replace characters by using the Find and Replace dialog box that is opened by selecting the  but-
ton on the toolbar. 

In the [Quick Find] tab of this dialog box, follow the procedure described below to search for characters.

Remark In the Find and Replace dialog box, various search/replace operation can be performed by selecting 
[Find in Files] tab, [Quick Replace] tab or [Replace in Files] tab. 
For details on each tab's functionality, see the section in which the corresponding tab is described.

Figure 2.7 Character Search (Find and Replace Dialog Box)

(1) Specify [Search text]
Enter characters to search. 
A word (including a variable, function, etc.) at the caret position in the Editor panel is specified by default. 
If you want to change it, directly enter the characters into the text box (up to 1024 characters) or select from the 
input history in the drop-down list (up to 10 history entries). 

(2) Specify [Search location] 
Select [Current document (file name)] from the drop-down list. 

(3) Click the [Find Previous]/[Find Next] button
When the [Find Previous] button is clicked, search will start in the order from the large address number to small 
and the search results are displayed selected in the Editor panel. 
When the [Find Next] button is clicked, search will start in the order from the small address number to large and 
the search results are displayed selected in the Editor panel. 

Remark Click the [Option] button to specify to use wild card, case sensitivity, word by word search, and so 
on. 

Incremental search can be started by pressing the shortcut keys (normally [Ctrl] + [I] or [Ctrl] + [Shift] + [I]).
In incremental search, search is performed at once when characters are input. The search results are displayed 

selected in the Editor panel.
The input character string is displayed on the status bar. If there are no matches, [Not found] is displayed on the status 

bar.
If the [Esc] key is pressed, incremental search is terminated.
Backward incremental search is the same as incremental search except for the search direction being reversed.

2.4.5  Use code outlining

When a C/C++ source file or a header file is opened, the code outlining function allows you to expand and collapse 
source code blocks so that you can concentrate on the areas of code which you are currently modifying or debugging. 

This is achieved by clicking an outline mark to the left of the source code.

Figure 2.8 Outline Mark of Code
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Caution This function is disabled when the Mixed display mode is selected. 

Remark To disable this function, unselect the [Enable code outlining] check box in the [Text Editor - General / 
Debug] category of the Option dialog box (the outline marks will be hidden). 

Types of source code blocks that can be expanded or collapsed are:

Caution Expanding and collapsing preprocessor statements is not possible unless the source and header files are 
registered with the project.

2.4.6  Use the smart edit function 

The smart edit function is used to complement the names of functions, variables and the arguments of functions during 
input to C/C++ source files and offer them as candidates.

The smart edit function operates with the items listed below.

- Global functions

- Global variables

- Struct or union members 

- Class member functions (only for C++ source files) [CC-RX]

- Class member variables (only for C++ source files) [CC-RX]

Figure 2.9 Display Example of Smart Edit Function

Caution 1. This function is supported only when the build tool provided by CS+ (CC-RH/CC-RX/CC-RL) is used (i.e. 
this function is disabled when an external build tool is used).

Caution 2. This function is disabled when the Mixed display mode is selected. 

Caution 3. The function does not work with structures where nesting is to the third level or deeper.

The smart edit function displays the following items.

(1)Candidates for functions/variables/arguments of functions
(2)Pop-up of the function/variable information

Note that follow the procedure below to enable the smart edit function. 

- Select the [Smart edit] check box in the [Text Editor - General / Debug] category of the Option dialog box (default). 

Open and close braces ('{' and '}')

Multi-line comments ('/*' and '*/')

Pre-processor statements ('if', 'elif', 'else', 'endif')
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- Candidates are displayed by using the cross reference information that is generated by the build tool.  Therefore, 
specify [Yes(-Xcref)][CC-RH][CC-RX]/[Yes(-cref)][CC-RL] with the [Output cross reference information] property on 
the Property panel of the build tool to be usedNote, and then run and complete a build. 
If an error in building occurs, the cross reference information before the error occurred is used if any exists. 

Note If this setting is invalid, the smart edit function cannot be used since the output will be empty of the 
cross reference information.

(1) Candidates for functions/variables/arguments of functions

(a) How to display
Candidates for functions/variables are displayed when:

- "." or "->" is input if there is a relevant member for the left side. 

- "::" is input if there is a relevant member for the left side (only for C++ source files) [CC-RX]. 

- The [Ctrl] + [Space] key on the keyboard is pressed (all candidates are displayed).
However, if there is only one candidate, the relevant character string is inserted at this time without displaying 
the candidate.

Caution If you enter an incomplete member name and press [Ctrl] + [Space], CS+ does not suggest a 
correct name.

Candidates for arguments of functions are displayed when:

- In a function name, "(" is input if there is a relevant function on the left side of "(".

- The [Ctrl] + [Shift] + [Space] key on the keyboard is pressed while the text cursor is at the location of an argu-
ment for a function.

(b) How to insert character strings
Select a character string from the candidates list by using the [Up]/[Down] key or the mouse, then press the 
[Enter] key or the [TAB] key. 

(c) Termination of the candidates display
The candidates display disappears by any one of the following methods.

- Press the [ESC] key

- Enter a key other than an alphanumeric character
When nothing is selected from the candidates list:  This operation has no effect.
When an item is selected in the candidates list:  The selected character strings are inserted.

(d) Description of each area (candidates for functions and variables)

Figure 2.10 Display of Candidates for Functions and Variables

<1> Candidates list
Displays candidates for functions and variables in alphabetical order.
If there are character strings that match to the character strings at the caret position, they are highlighted 
(case insensitive). 
The following icons are displayed as labels for the list of candidates.

Candidates list

Toolbar

Tab

Detailed display

(1) (2) (3)

(4) (5)
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<2> Toolbar
Switches whether candidates for functions and variables are displayed or not.

<3> Tab
Switches the members to be displayed. 

<4> Detailed display
Displays details of candidates for functions or variables currently being selected. 

Icon Description

Shows that the candidate is for a typedef. 

Shows that the candidate is for a function. 

Shows that the candidate is for a variable. 

Shows that the candidate is for a class type. [CC-RX]

Shows that the candidate is for a structure type.

Shows that the candidate is for an union type.

Shows that the candidate is for a namespace. [CC-RX]

Shows that the candidate is for a protected member. [CC-RX]

Shows that the candidate is for a private member. [CC-RX]

Button Description

Displays candidates for functions. 

Displays candidates for variables. 

Tab Name Description

All members Displays all candidates.

Public members Displays only the candidates with the public attribute.

Item Description

(1) Kind Shows whether the selected item is a function or a variable.
(function): Shows the selected item is a function.
(variable): Shows the selected item is a variable. 

(2) Type Shows the type of the function or the variable.

(3) Name Shows the name of the function or the variable.

(4) Attribute and type Shows the type of the function or the variable.
[CC-RX]

When the attribute is defined, the access specifier (public/protected/pri-
vate)  is displayed at the head. 

(5) Name and argument Shows the name of the function or the variable. 
When the item is a function, its arguments are also shown.
[CC-RX]

When the item is an overloaded function, the number of times overloaded 
is displayed in parentheses "( )".
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(e) Description of each area (candidates for arguments of functions)

Figure 2.11 Display of Candidates for Arguments of Functions

(f) Notes for displaying of candidates list

- The following items are not the subject of the candidates display.

- Macro definitions

- Local variables

- Typedef statements

- When a structure, union or class [CC-RX] is declared within a function, candidates are not displayed within 
the function after its own declaration.

- In some cases the type of variables to be displayed differs from that actually declared when a compiler option 
which affects the size of variables is set.

- const and mutable attribute are not displayed. 

- For C++ source files [CC-RX]

- Namespaces and subclasses (classes declared within classes) are not supported.

- Candidates for the names of functions and variables are not displayed in response to the input of "(*class)" 
or "(*this)".

- Candidates for the names of functions and variables are not displayed for an array declared within a class.

- When candidates for the names of functions and variables are displayed by using the [Ctrl] + [Space] key 
combination while a class name is specified to the left and input of a method name is incomplete, the can-
didates displayed are the names of global functions and variables instead of candidates for the names of 
functions and variables in the class.

(2) Pop-up of the function/variable information
When the mouse cursor is hovered over a function name or a variable name on the source text, the information 
about that function or variable appears in a pop-up.
Note the following, however, when using this function. 

- This function cannot be used when connected to the debug tool.

- Structures/unions and member functions [CC-RX] declared in header files cannot be displayed in a pop-up.

- If arguments for the function include a call of another function, incorrect information will be displayed in a pop-
up.

Example myClass.func(myClass.funcStr(

Item Description

(1) Type Shows the type of the function or the variable.

(2) Name and argument Shows the name of the function and its arguments. 
The argument at the current caret position is highlighted. 

(3) Candidate for argument Shows the name of the function and its arguments. 

(4) Attribute Shows the attribute (public/protected/private) of the argument. [CC-RX]

(5) Name and argument Shows the number of candidates if multiple candidates exist.  
Click the  or  mark to change the candidate.

(1) (2)

(3)

(5)

(3)
(4)
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- const, static, volatile and virtual [CC-RX] attributes cannot be displayed in a pop-up.

- If the target is a variable of class [CC-RX], structure, union, or enumeration type, its members are displayed as 
follows:

- If the target is a class- [CC-RX], structure-, or union-type variable, the types and names of its members are 
displayed.
If the target is a class-type variable [CC-RX] that includes methods (functions) among its members, the types 
of the return values and names of the methods (functions) are displayed. Also, "(" ")" is appended to the end 
of each method name.

- If the target is an enumeration-type variable, only the names of the members are displayed.

- Members are displayed in the same order as they are defined in the source file, and each is placed on a sin-
gle line (up to 20 members can be displayed). 

- For C++ source files [CC-RX]
friend attribute is not supported. 

The meaning of each icon displayed in a pop-up is described below.

Figure 2.12 Pop-up Display of Smart Edit Function

Caution Even if you hover the mouse over code immediately after #ifdef to #endif, no information on the function 
or variable will be displayed in a pop-up. Members will not be suggested either.
Also, no information on a first variable between #ifdef and #endif will be displayed in a pop-up if you place 
the mouse over the variable in code that follows #endif. Members will not be suggested either.

2.5  Move to the Specified Line

You can move to the specified line by using the Go to Line dialog box that is opened by selecting [Go to...] from the con-
text menu. 

In this dialog box, follow the procedure described below to move to a specified line.

Icon Description

Shows that the target is for a typedef. 

Shows that the target is for a function. 

Shows that the target is for a variable. 

Shows that the target is for a class type. [CC-RX]

Shows that the target is for a structure type.

Shows that the target is for an union type.

Shows that the target is for a namespace. [CC-RX]

Shows that the target is for an enumeration type.

Mouse cursor
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Figure 2.13 Move to Specified Line (Go to Line Dialog Box)

(1) Specify [Line number (valid line range) or symbol]
Directly enter the line number (decimal number), symbol nameNote 1 or addressNote 2 to which you want to move 
the caret.
"(valid line range)" shows the range of valid lines in the current file.
By default, the number of the line where the caret is currently located in the Editor panel is displayed. 

Note 1. Note the following, when specifying a symbol name:

- Either a function name or a variable name can be specified as a symbol name. 

- On the Property panel of the build tool to be used, specify [Yes(-Xcref)][CC-RH][CC-RX]/[Yes(-
cref)][CC-RL] with the [Output cross reference information] property, and then run and complete 
a build. 

- If an error in building occurs, the cross reference information before the error occurred is used.

Note 2. Note the following, when specifying an address:

- Enter a hexadecimal number with prefix "0x" or "0X" added (a decimal number is handled as a 
line number).

- Run and complete a build. 

- If an error in building occurs, the information before the error occurred is used.

(2) Click the [OK] button
Caret is moved to the specified line. 

2.6  Jump to Functions or Variables

While a source file is open in the Editor panel, you can make CS+ recognize the currently selected string or the word at 
the position of the caret as a function or variable name and jump to the corresponding function or variable. 

After a jump, the name of the given function or variable is indicated as being selected. If the compiler has not output 
cross-reference information, however, the jump to a function will be to the first line of executable code within the function, 
and jumping to variables will not work.

Select [Jump to Function or Variable] from the context menu after moving the caret to the target function or variable on 
the source text. 

Caution 1. When multiple statements are described in a line, a jump to an illegal location may be made.

Caution 2. For C++ source files [CC-RX]
The following notes apply to the selection of functions within C++ source files if CC-RX is in use.

- When a given character string does not fully specify the desired function, jumping may not be possible 
or the jump may actually be to a different function with the same name.

- Member functions in classes
The name of the class to which the target function belongs must be included. When other functions 
have the same name as the target function but the arguments are different, also include the argument 
types.

- Functions defined in namespaces
The full name of the namespace to which the target function belongs must be included. When other 
functions have the same name as the target function but the arguments are different, also include the 
argument types.

- Template functions
The types of the arguments must be included in the case of functions generated by the compiler.



R20UT4972EJ0100  Rev.1.00 Page 19 of 78
Jun 01, 2021

CS+ V8.06.00 2.  FUNCTIONS

Caution 3. A jump to a variable is only possible when the compiler has output cross-reference information.

Remark The judgement of words will depend on the build tool being used.

Figure 2.14 Jump to Functions or Variables

Note that this function is available only when the following conditions are satisfied for each specific build tool.

(1) When CC-RH/CC-RX/CC-RL is used

(a) When [Yes(-Xcref)][CC-RH][CC-RX]/[Yes(-cref)][CC-RL] is specified with the [Output cross reference informa-
tion] property of the build tool

- Run and complete a build.

Remark 1. If functions with the same name exist, then the Jump to Function dialog box will be opened, and 
you can select the jump destination function. 

Remark 2. When a function and a variable with the same name exist, the jump to the function takes prece-
dence.

(b) When [No] is specified with the [Output cross reference information] property of the build tool, the scope of the 
operation becomes only functions, not variables

- When disconnected from the debug tool:

- The type of the project specified as the active project is "Application". 

- The target function is a global function. 

- The target function is defined in a file that is specified as the first file in the [Download files] property in the 
[Download] category on the [Download File Settings] tab of the Property panel.  In addition, the file includes 
the symbol information. 

- When connected to the debug tool and downloaded the load module file:

- The downloaded load module file includes the symbol information for the function.

- Calling the target function from the file corresponding to the address of the program counter (PC).
For example, a jump to a static function defined other than in the file corresponding to the address of the 
program counter (PC) is not possible.

(2) When an external build tool is used, the scope of the operation becomes only functions, not variables

- The target function resides in an active project.  In case it is disconnected from the debug tool, a jump to a static 
function cannot be made.
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- A file with the symbol informationNote is specified with the [Download files] property in the [Download] category 
on the [Download File Settings] tab of the Property panel.  In case it is disconnected from the debug tool, the 
above file is specified as the first file in the [Download files] property.

Note When the file is in the format other than the load module file, the setting for downloading the symbol 
information is required (see "CS+ Integrated Development Environment User's Manual: Debug 
Tool"). 

2.7  Jump to a Desired Line (Tag Jump)

If the information of a file name, a line number and a column number exist in the line at the caret position, you can open 
the file in another Editor panel and jump to the corresponding line and the corresponding column (if the Editor panel is 
already open, you can jump to the panel). 

Select [Tag Jump] from the context menu after moving the caret to the line in the characters area. 
The tag jump is operated as follows:

Table 2.3 Operation of Tag Jump

Figure 2.15 Tag Jump

Remark 1. Jumps are case-insensitive. 

Remark 2. The reference point of the path is the project folder in which the file is registered.  If the file is not regis-
tered in any project, the reference point of the path will be the active folder. 

Remark 3. Path specifications (path/file names) including space characters must be enclosed in "".

2.8  Register Bookmarks

You can register a bookmark to the line at the current caret position by clicking the  button on the bookmark toolbar.  
Once a bookmark is registered, the bookmark (  ) is displayed in the [Main] area. 

When this operation is performed at a place where a bookmark is already being registered, that bookmark is deleted.  
Up to 50 bookmarks can be registered in one Editor panel. 

Example of Character String Operation

C:\work\src.c Jumps to the top line of the file "C:\work\src.c".

Tmp\src.c Jumps to the top line of the file "Tmp\src.c".
(The reference point of the path is the project folder.)

C:\work\src.c(10) Jumps to the tenth line from the top of the file "C:\work\src.c".

C:\"work sub\src.c"(10) Jumps to the tenth line from the top of the file "C:\"work sub\src.c"".

C:\work\src.c(10,5) Jumps to the fifth column of the tenth line from the top of the file "C:\work\src.c".
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Caution 1. When the Mixed display mode is selected, bookmarks cannot be registered nor displayed. 

Caution 2. After a line with a bookmark is deleted, the bookmark cannot be restored even if the [Edit] menu >> 
[Undo] is selected. 

Figure 2.16 Register Bookmark

Remark 1. The bookmark information is saved in the currently open project file and restored when that project is re-
opened.  Therefore, if bookmarks are set in a file that does not belong to the project, those bookmarks 
will not be restored.

Remark 2. Clicking on the  and  buttons on the bookmark toolbar moves the caret to the previous and next 
bookmarks, respectively.  Note that the bookmarks are listed in the order of their registration (not in the 
order of line numbers).

Remark 3. Bookmarks currently being registered are listed on the Bookmarks dialog box that is opened by clicking 
the  button on the bookmark toolbar. 

2.9  Change Display Mode

You can change the display mode of the Editor panel by clicking the  button (toggle) on the toolbar. 

Caution This function is enabled only when connected to the debug tool and the downloaded source file is 
opened in this panel. 

(1) Normal display mode
In this display mode (default), the line number, address and source text, etc. are displayed. 

Figure 2.17 Normal Display Mode

(2) Mixed display mode
In this display mode, the code data, label and disassembled text are displayed combined with the source text.

Figure 2.18 Mixed Display Mode

Caution 1. In the mixed display mode, the source text and the corresponding code information that were 
acquired from the downloaded load module file are displayed.  Therefore, to display the source text 
that has been modified in the mixed display mode, you need to run a rebuild and download it. 

Caution 2. In the mixed display mode, the source files cannot be edited.  In addition, [Redo]/[Cut]/[Paste]/
[Delete]/[Select All]/[Replace...]/[Bookmark]/[Outlining]/[Advanced] from the [Edit] menu are dis-
abled. 

Line number Address

Source text

Code

Label

Disassembled text

Source text

Address

Line number
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Caution 3. When the mixed display mode is selected in the Editor panel, the sequence of instruction execution 
for statements within a function to which inline expansion is applied is not displayed in the inline-
expanded part (part where the function is actually called).  Instead, it is displayed in the function of 
the source for inline-expansion.
In the function of the source for inline-expansion, the number of sequences of instruction execution 
added and displayed is the same as the number to which inline-expansion is applied.

Remark You can save the contents of the current mixed display to a file in the text or CSV format by select-
ing [Save Source Mixed Data As...] from the [File] menu (the contents of hidden columns cannot be 
saved). 

2.10  Display Variables

When hovering the mouse cursor over a variable in the source text, a pop-up that shows the name and value of the vari-
able is displayed ("<variable name>=<variable value>").

The display format of the variable value is same as the display format of watch expressions depending on the type of 
the variable.

Caution This function is enabled only when connected to the debug tool and the downloaded source file is 
opened in this panel. 

Remark For details on the display format of watch expressions, see "CS+ Integrated Development Environment 
User's Manual: Debug Tool". 

Figure 2.19 Pop-up Display of Variables 

2.11  Display Multiple Source Files Sequentially in a Single Panel

If the current PC moves between multiple source files when debugging (e.g. when performing step execution), each of 
the source files will be opened in a separate Editor panel.  If this is the case, the recycle mode lets you display multiple 
source files sequentially in a single Editor panel.

Select the [Use window recycling] check box on the [Text Editor - General / Debug] category in the Option dialog box to 
enable this feature.

Caution 1. This function is enabled only when connected to the debug tool and the downloaded source file is 
opened in this panel. 

Caution 2. When the current PC value in program execution corresponds to a line in the Editor panel while editing is 
being conducted in the recycle mode, that Editor panel is released from the recycle mode, and a new 
Editor panel is opened in the recycle mode.

Remark If the Editor panel that displays the corresponding source file is already opened, then the source file is 
not opened in the panel of the recycle mode, but the Editor panel being opened is displayed.

Mouse cursor
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Figure 2.20 Normal Operation

Figure 2.21 Recycle Mode Operation

2.12  Set/delete Various Events

In the main area, address marks (  ) are displayed at lines that have valid addresses.
You can set/delete breakpoints or various events at lines with the address mark.

Caution This function is enabled only when connected to the debug tool and the downloaded source file is 
opened in this panel. 

(1) Setting/deleting breakpoints
In the Main area, click the line that has the address mark (  ) with the mouse to set a breakpoint.
Once a breakpoint is set, an event mark (  or  ) is displayed at the line that is set.  In addition, the detailed 
information about the set breakpoint is reflected in the Events panel.
If this operation is performed at a place where a breakpoint is already set, that breakpoint is deleted and the set-
ting of breakpoints cannot be done.

A new panel is opened.

Execute

"[RECYCLE]" is displayed following the file name. 

The source file is displayed in the same panel.

Execute
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For details on how to set a breakpoint, see "CS+ Integrated Development Environment User's Manual: Debug 
Tool".

Remark Setting a breakpoint and changing the state of a breakpoint can also be done from the context 
menu on the main area.

(2) Setting/deleting various events
In the Event area or the Characters area, select a item from the context menu on the line that has the address 
mark (  ).
Once an event is set, an event mark (  ,  ,  ,  , etc.) is displayed at the line that is set.  In addition, the 
detailed information about the set event is reflected in the Events panel.
For details on how to set various events (break event, Trace event, Timer Result event, Performance Measure-
ment event, action event, etc.), see "CS+ Integrated Development Environment User's Manual: Debug Tool".

Remark 1. For details on how to set various events and about event marks displayed, see "CS+ Integrated 
Development Environment User's Manual: Debug Tool".

Remark 2. By hovering the mouse cursor over the event mark displayed, the name of the event, the detailed 
information for the event and the comments added to the event are a pop-up displayed.  When mul-
tiple events have been set in the applicable place, information for each event, up to a maximum of 
three events, is listed and displayed.

Remark 3. To set or delete the insertion point for the dbtag instruction for measuring the CAN bus reception 
processing time or the monitor points for measurement of current consumption, use the context 
menu of the Characters area.
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A.  WINDOW REFERENCE

This appendix describes in detail the windows, panels and dialog boxes used with the editor features that CS+ provides.

A.1  Description

Windows/panels/dialog boxes used with the editor features are listed below. 

Table A.1 Window/Panel/Dialog Box List

Window/Panel/Dialog Box Name Description

Editor panel Enables text files to be viewed and edited, and is used to execute 
source level debug.

Encoding dialog box Selects a file-encoding.

Save Settings dialog box Specifies the encoding and the new line code of the file being edited. 

Find and Replace dialog box Finds and replaces the designated characters.

Go to Line dialog box Moves the caret to the specified line. 

Jump to Function dialog box Selects a function to which the caret moves.

Bookmarks dialog box Displays and deletes bookmarks.

Print Preview window Previews the source file before printing. 
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This panel is used to display and edit files.
Furthermore, the source level debugging, instruction level debugging and the code coverage measurement result dis-

playNote can be performed when connected to the debug tool and the downloaded source file is opened in this panel.
The code data, label and disassembled text can be displayed combined with the source text by selecting the Mixed dis-

play mode (see "2.9Change Display Mode"). 
When opened the file encoding and newline code is automatically detected and retained when it is saved. You can open 

a file with a specific encoding selected in the Encoding dialog box. If the encoding and newline code is specified in the 
Save Settings dialog box then the file is saved with those settings.

This panel can be opened multiple times (up to 100 panels). 

Note The code coverage measurement result is displayed only when the selected debug tool supports the cov-
erage function. 

Caution 1. When a project is closed, all of the Editor panels displaying a file being registered in the project are 
closed.

Caution 2. When a file is excluded from a project, the Editor panel displaying the file is closed.

Figure A.1 Editor Panel (When Disconnected from Debug Tool)

Editor panel

(1)

(4) (12) (13)

(3)

(3)

[Toolbar]

(2)

(5)
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Figure A.2 Editor Panel (When Connected to Debug Tool)

Figure A.3 Editor Panel (When Code Coverage Measurement Result Is Displayed) 
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Figure A.4 Editor Panel (When Mixed Display Mode Is Selected)

Remark 1. This panel can be zoomed in and out by  in the tool bar, or by moving the mouse 
wheel forward or backward while holding down the [Ctrl] key. 

Remark 2. When a file whose size is greater than 24MB is opened, a message dialog box is shown for confirmation 
of whether or not to disable all of the functions listed below (if you select [No] in this message dialog box, 
the operation speed may become sluggish).

- Syntax (reserved words, comments, etc.) coloring

- Code outlining

- Smart edit function

This section describes the following.

- [How to open]

- [Description of each area]

- [Toolbar]

- [[File] menu (Editor panel-dedicated items)]

- [[Edit] menu (Editor panel-dedicated items)]

- [[Window] menu (Editor panel-dedicated items)]

- [Context menu]

[How to open]

- On the Project Tree panel, double-click a file.

- On the Project Tree panel, select a file, and then select [Open] from the context menu.

- On the Project Tree panel, select a file, and then select [Open with Internal Editor...] from the context menu.

- Automatically opens after downloading the load module file with debug information.

- On the Project Tree panel, select [Add] >> [Add New File...] from the context menu, and then create a text file or 
source file.

- On the Disassemble panel, Call Stack panel, Trace panel, or Events panel, select [Jump to Source] from the context 
menu.

(1)

(4) (7) (8) (12)(11) (13)

(3)

(3)

[Toolbar]

(2)

(9) (10)
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- Automatically opens if there is a source text line corresponding to the current PC value when the current PC value is 
forcibly changed or the program stops executing.

[Description of each area]

(1) Title bar
The name of the opened file is displayed.
Marks displayed at the end of the file name indicate the following:

(2) Column header
The title of each column on the Editor panel is displayed. 
Hovering the mouse cursor over this area displays the title name. 

Remark Show/hide of the column header can be switched by the setting of the toolbar. 

Mark Description 

* The file has been modified since being opened.

! Update time and date of the source file opened are later than the one of the downloaded load 
module file.
Note that this mark is valid only when connected to the debug tool and the downloaded source 
file is opened.

[RECYCLE] The recycle mode (see "2.11Display Multiple Source Files Sequentially in a Single Panel") is 
valid.
Note that this mark is valid only when connected to the debug tool and the downloaded source 
file is opened. 

(Read only) The opened file is read only.

Display Title Name Description

Line Line Displays line numbers (see "(4)Line number area"). 

(No dis-
play)

Selection The display is colored to reflect the state in terms of saving of the state of 
editing (see "(5)Selection area"). 
However, this column is not displayed in the Mixed display mode.

(No dis-
play)

Out of Date Mod-
ule Indicator

The display is colored to reflect cases where a source file has been updated 
more recently than the corresponding load module file (see "(6)Out of date 
module Indicator area"). 
However, this column is not displayed when disconnected from the debug 
tool or in the Mixed display mode. 

Coverage Displays the coverage information (see "(7)Coverage area"). 
However, this column is not displayed when disconnected from the debug 
tool. 

Address Address Displays addresses (see "(8)Address area"). 
However, this column is not displayed when disconnected from the debug 
tool. 

Op code Op code Displays instruction codes (see "(9)Op code area"). 
However, this column is displayed only in the Mixed display mode. 

Label Label Displays labels (see "(10)Label area"). 
However, this column is displayed only in the Mixed display mode. 

Event Sets events (see "(11)Event area"). 
However, this column is not displayed when disconnected from the debug 
tool. 

Main Displays bookmarks, address marks and the current PC mark. 
Furthermore, sets breakpoints (see "(12)Main area"). 



CS+ V8.06.00 A.  WINDOW REFERENCE

R20UT4972EJ0100  Rev.1.00 Page 30 of 78
Jun 01, 2021

(3) Splitter bars
This item splits the panel. 
For details on how to do it, see "2.3Split the Panel". 

Caution The split is enabled only when this panel is in the normal display mode (setting to the Mixed display 
mode removes the split).

(4) Line number area
This area displays the line number of the opened file.

(5) Selection area
This area displays the following indicators that shows the line modification status (except in the Mixed display 
mode).

(6) Out of date module Indicator area
This area is valid only when connected to the debug tool and the downloaded source file is opened (except in the 
Mixed display mode).
If the update time and date of the source file opened are later than the one of the downloaded load module file, the 
following indicator is displayed (the color of the indicator depends on the "Warning" color of the [General - Font 
and Color] category of the Option dialog box). 
To erase this mark, run a build and then download the load module file again.

(7) Coverage area
This area is valid only when connected to the debug tool and the downloaded source file is opened.
When the coverage function is valid, lines corresponding to the specified coverage measurement area are shown 
highlighted based on the code coverage measurement result that is acquired by executing the program (the color 
depends on the coverage color in the [General - Font and Color] category of the Option dialog box).
For details on the coverage function, see "CS+ Integrated Development Environment User's Manual: Debug Tool".

(8) Address area
This area is valid only when connected to the debug tool and the downloaded source file is opened.
This area shows the address corresponding to where the instruction is located in the memory space of the 
selected microcontroller.
The format of this area is fixed as hexadecimal number notation.
The address width corresponds to the one in memory space of the selected microcontroller in the project.

(9) Op code area
This area is valid only when connected to the debug tool and the downloaded source file is opened in the Mixed 
display mode.
This area shows the instruction code corresponding to the source text. 

(10) Label area
This area is valid only when connected to the debug tool and the downloaded source file is opened in the Mixed 
display mode.
This area shows the label name when a label is defined for the address. 

(11) Event area
This area is valid only when connected to the debug tool and the downloaded source file is opened.
This area displays event marks that indicate various events that are currently set and can be used to set or delete 
various events.

This means new or modified line but unsaved.

This means new or modified line and saved.
To erase this mark, close the panel, and then open this source file again. 
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By selecting a item from the context menu on the line that has the address mark (  ), a Timer Result event, Per-
formance Measurement event, Trace event or action event (Printf event) can be set/deleted (see "2.12Set/delete 
Various Events"). 
In a project for which measurement of current consumption by the MCU is enabled, you can also set, delete, 
enable, or disable monitor points in the event area. [RL78]

Caution Setting of monitor points for current is only possible when you are using an E2 emulator as the 
debug tool and an MCU other than the RL78/G10.

Remark For details on the event marks and measurement of the current consumption, see "CS+ Integrated 
Development Environment User's Manual: Debug Tool".

(12) Main area
This area is provided with the following functions.

(a) Error marks and warning marks display
When an error or warning has been output via the last build commandNote, an error mark (  ) or warning mark 
(  ) is displayed at the corresponding line. 
To erase these marks, run a clean. 

Note Compiling or assembling of source files and running a build, rebuild, or rapid build of the project

Figure A.5 Error Marks and Warning Marks Display 

Caution 1. This function is disabled when connected to the debug tool.

Caution 2. This function targets only a source file that have been registered in the project.

Caution 3. Even when the line number of the source text is changed by modifying, the position of a mark 
currently being displayed is not moved.

(b) Bookmarks display
Bookmarks (  ) that have been registered are displayed (see "2.8Register Bookmarks").

Caution This function is disabled when the Mixed display mode is selected. 

The following functions are also available when the debug tool is connected and a downloaded source file is open.

(c) Address marks display
Address marks (  ) are displayed at lines that have valid addresses.
Breakpoints or various events can be set at lines with the address mark. 

(d) Current PC mark display
The current PC mark (  ) that corresponds to the current PC position (PC register value) is displayed.
Note that the current PC mark is only displayed if the current PC value corresponds to the source text line, when 
the state of the debug tool is changed from execution to stop.

Remark When the Mixed display mode is selected, if the unit of step execution is set to instruction level by 
selecting the  button on the toolbar, then the current PC mark will be moved to a disassem-
bled text line.

When hovering the mouse cursor over a mark, 
a pop-up that shows the corresponding mes-
sage is displayed.
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(e) Setting/deleting of breakpoints
This area displays event marks that indicate breakpoints currently being set and sets/deletes breakpoints.
By clicking the line that has the address mark (  ) with the mouse, the breakpoints can be set easily (see 
"2.12Set/delete Various Events").

Remark 1. Setting a breakpoint and changing the state of a breakpoint can also be done from the context 
menu in this area.

Remark 2. For details on the event marks, see "CS+ Integrated Development Environment User's Manual: 
Debug Tool".

(f) Setting/deleting of the insertion point for the dbtag instruction for measuring the CAN bus reception processing 
time [E2 emulator [RH850]]
This area displays the insertion point for the dbtag instruction for measuring the CAN bus reception processing 
time currently being set and sets/deletes the insertion point.
To set or delete a point where the dbtag instruction is to be inserted, use the [Set Measuring CAN Bus Recep-
tion Processing Time] cascading menu item from the context menu.

Caution Measurement of CAN bus reception processing times is only available if you are using V1.06 or a 
later version of the CC-RH compiler and an RH850 MCU that includes an RS-CAN, RS-CANFD, 
or MCAN module.

Remark For details on the solution for measuring the CAN bus reception processing time, see "CS+ Inte-
grated Development Environment User's Manual: Debug Tool".

(13) Characters area
This area displays character strings of files and you can edit it.
This area is provided with the following functions.

(a) Characters editing
Characters can be entered from the keyboard.
Various shortcut keys can be used to enhance the edit function (see "2.4Edit Characters"). 

Caution This function is disabled when the Mixed display mode is selected. 

(b) Customization of basic display
The following items can be customized by setting the Option dialog box (the Option dialog's category name to 
customize the item is shown in "()".  For details on the Option dialog box, see "CS+ Integrated Development 
Environment User's Manual: Project Operation").

- Display fonts ([General - Font and Color] category)

- Tab width ([General - Display] category)

- Show or hide white space marks ([Text Editor - General / Debug] category)

- Color of syntax (reserved words, comments, etc.) ([Text Editor - General / Debug] category)

- Highlighting the current line ([Text Editor - General / Debug] category) (see "2.4.1Highlight the current line")

Caution About reserved words:
For I/O registers [RH850][RX]/SFRs [RL78], reserved words that are defined in the device 
dependent information file are highlighted (i.e. the character strings that are displayed in the IOR 
panel [RH850][RX]/SFR panel [RL78] of the debug tool are highlighted). 
Unlike the definition of iodefine.h, a build error may occur. 

(c) Emphasizing brackets
The bracket that corresponds to a bracket at the caret position is shown emphasized (see "2.4.2Emphasize 
brackets"). 

(d) Multiple lines selection and block selection
You can select multiple lines or a block that consists of multiple lines (see "2.4.3Select characters"). 

Caution The information on bookmarks is not included in the selected contents.

(e) Code outlining
When a C/C++ source file or a header file is opened, you can expand and collapse source code blocks so that 
you can concentrate on the areas of code which you are currently modifying or debugging (see "2.4.5Use code 
outlining"). 

Caution This function is disabled when the Mixed display mode is selected. 
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(f) Smart edit function 
The smart edit function is used to complement the names of functions, variables and the arguments of functions 
during input and offer them as candidates (see "2.4.6Use the smart edit function"). 
The smart edit function operates with the items listed below.

(g) Jump to functions or variables
It automatically recognizes the currently selected characters or the word at the caret position as the function 
name or the variable name and jumps to the target function or variable (see "2.6Jump to Functions or Vari-
ables"). 

(h) Tag jump
If the information of a file name, a line number and a column number exists in the line at the caret position, 
selecting [Tag Jump] from the context menu opens the file in a new Editor panel and jumps to the corresponding 
line and the corresponding column (see "2.7Jump to a Desired Line (Tag Jump)"). 

(i) Registration of bookmarks
By clicking the  button on the bookmark toolbar or selecting [Bookmark] >> [Toggle Bookmark] from the con-
text menu on this area, a bookmark can be registered to the line at the caret position (see "2.8Register Book-
marks"). 

Caution This function is disabled when the Mixed display mode is selected. 

(j) File monitor
If the contents of the currently displayed file is changed (including renaming or deleting) without using CS+, a 
message will appear asking you whether you wish to update the file or not.

The following functions are also available when the debug tool is connected and a downloaded source file is open.

(k) Highlighting the current PC line
When the current PC position (PC register value) corresponds to the source text lines, those lines are shown 
highlighted (the highlighting color depends on the current PC color in the [General - Font and Color] category of 
the Option dialog box).

(l) Highlighting lines with breakpoints
Lines where the breakpoints are set are shown highlighted (the highlighting color depends on the breakpoint 
color in the [General - Font and Color] category of the Option dialog box).

(m) Code coverage measurement result display 
When the debug tool to be used supports the coverage function and its function is enabled, then lines corre-
sponding to the specified coverage measurement area are shown highlighted based on the code coverage 
measurement result that is acquired by executing the program (the highlighting color depends on the coverage 
color in the [General - Font and Color] category of the Option dialog box).  
For details on the coverage function, see "CS+ Integrated Development Environment User's Manual: Debug 
Tool".

(n) Pop-up display of variables
When hovering the mouse cursor over a variable in the source text, a pop-up that shows the name and value of 
the variable is displayed (see "2.10Display Variables").

Remark When hovering the mouse cursor over a constant, a pop-up that shows the value the same as 
the constant value is displayed because a constant is interpreted as a numeric value.

(o) Setting of various events
By selecting a item from the context menu on the line that has the address mark (  ), various events can be set 
(see "2.12Set/delete Various Events").

(p) Registration of watch expressions
C+C++ language variable, CPU registers, I/O registers [RH850][RX]/SFRs [RL78], and assembler symbols can 
be registered in the Watch panel as watch expressions.
For details on how to register watch expressions, see "CS+ Integrated Development Environment User's Man-
ual: Debug Tool".
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[Toolbar]

Toggles between the normal display mode (default) and the mixed display mode, as the display 
mode of this panel (see "2.9Change Display Mode"). 
Note that this item is enabled only when connected to the debug tool and the downloaded 
source file is opened in this panel. 

Toggles between source (default) and instruction level, as the unit in which the program is step-
executed. 
When the unit of a step execution is set to instruction level, then the current PC mark will be 
moved to a disassembled text line
Note that this item is enabled only when connected to the debug tool and the downloaded 
source file is opened in this panel. 

Displays the current PC position. 
Note that this item is enabled only when connected to the debug tool. 

Forwards to the position before operating [Back To Last Cursor Position].
Note that this item is disabled when this panel is in the mixed display mode.

Goes back to the position before operating [Jump to Function or Variable]/[Find...]/[Go To...]/
[Next Bookmark]/[Previous Bookmark] or moving the caret by clicking the mouse. 
The jump history is cleared when all of the Editor panel currently being opened are closed. 
Note that this item is disabled when this panel is in the mixed display mode.

Columns The following items are displayed to show or hide the columns or marks on all of the Editor pan-
els. 
Remove the check to hide the items (all the items are checked by default).
This setting is reflected in all the Editor panels.

Line Number Shows the line number, in the line number area.

Selection Shows the mark that indicates the line modification status, in the line number area.

Out of date 
module indica-
tor

Shows the mark that indicates the update status of the downloaded load module file, in the line 
number area.
Note that this item is enabled only when connected to the debug tool. 

Coverage Shows the coverage area.
Note that this item is enabled only when connected to the debug tool. 

Address Shows the address area.
Note that this item is enabled only when connected to the debug tool. 

Op Code Shows the code area.
Note that this item is enabled only when connected to the debug tool and the mixed display 
mode is selected.

Label Shows the label area.
Note that this item is enabled only when connected to the debug tool and the mixed display 
mode is selected.

Event Shows the event area.
Note that this item is enabled only when connected to the debug tool. 

Main Shows the main area.

Column Header Shows the column header.
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[[File] menu (Editor panel-dedicated items)]

The following items are exclusive for the [File] menu in the Editor panel (other items are common to all the panels). 

[[Edit] menu (Editor panel-dedicated items)]

The following items are exclusive for [Edit] menu in the Editor panel (all other items are disabled). 

Close file name Closes the currently editing Editor panel. 
When the contents of the panel have not been saved, a confirmation message is shown.

Save file name Overwrites the contents of the currently editing Editor panel. 
When the file has never been saved or the file is read only, the same operation is applied 
as the selection in [Save file name As...]. 
Note that this item is disabled when this panel is in the mixed display mode. 

Save file name As... Opens the Save As dialog box to newly save the contents of the currently editing Editor 
panel. 
Note that if this panel is in the mixed display mode, then "file name" will be changed to 
"Source Mixed Data". 

File name Save Set-
tings...

Opens the Save Settings dialog box to change the encoding and newline code of the file 
being opened in the currently editing Editor panel. 

Page Setup... This item is always disabled.

Print... Opens the Windows dialog box for printing the contents of the currently editing Editor 
panel.

Print Preview Opens the Print Preview window to preview the file contents to be printed. 

Undo Cancels the previous operation and restores the characters and the caret position (up to 
100 times).
Note that this item is disabled when this panel is in the mixed display mode.

Redo Cancels the previous [Undo] operation and restores the characters and the caret position. 
Note that this item is disabled when this panel is in the mixed display mode.

Cut Cuts the selected character string and copies it to the clipboard. 
If there is no selection, the entire line is cut. 
Note that this item is disabled when this panel is in the mixed display mode.

Copy Copies the contents of the selected range to the clipboard as character string(s). 
If there is no selection, the entire line is copied. 

Paste Inserts (insert mode) or overwrites (overwrite mode) the characters that are copied on the 
clip board into the caret position. 
Note that this item is disabled when the contents of the clipboard are not recognized as 
characters or this panel is in the mixed display mode. 

Delete Deletes one character at the caret position. 
When there is a selection area, all the characters in the area are deleted. 
Note that this item is disabled when this panel is in the mixed display mode.

Select All Selects all the characters from beginning to the end in the currently editing text file. 
Note that this item is disabled when this panel is in the mixed display mode.

Find... Opens the Find and Replace dialog box with selecting [Quick Find] tab . 

Replace... Opens the Find and Replace dialog box with selecting [Quick Replace] tab . 
Note that this item is disabled when this panel is in the mixed display mode.

Go To... Opens the Go to Line dialog box to move the caret to the specified line. 
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Bookmark Displays a cascading menu for bookmarks (see "2.8Register Bookmarks"). 

Toggle Bookmark Inserts/deletes a bookmark on the line at the current caret position.
Note that this item is disabled when this panel is in the mixed display mode.

Next Bookmark Moves a caret to the position of the next bookmark, in the active Editor panel.
Note that this item is disabled in the following cases: 
No bookmark is registered.
A bookmark is registered only in one line with a caret.
This panel is in the mixed display mode. 

Previous Bookmark Moves a caret to the position of the previous bookmark, in the active Editor panel.
Note that this item is disabled in the following cases: 
No bookmark is registered.
A bookmark is registered only in one line with a caret.
This panel is in the mixed display mode. 

Clear All Bookmarks Clears all the registered bookmarks, in the active Editor panel. 
Note that this item is disabled in the following cases: 
No bookmark is registered.
This panel is in the mixed display mode. 

List Bookmarks... Opens the Bookmarks dialog box for displaying the list of bookmarks.
Note that this item is disabled when the project is closed. 

Outlining Displays a cascading menu for controlling expand and collapse states of source file outlin-
ing (see "2.4.5Use code outlining"). 
Note that these items are disabled when this panel is in the mixed display mode.

Collapse to Defini-
tions

Collapses all nodes that are marked as implementation blocks (e.g. function definitions). 

Toggle Outlining 
Expansion

Toggles the current state of the innermost outlining section in which the cursor lies when 
you are in a nested collapsed section. 

Toggle All Outlining Toggles the collapsed state of all outlining nodes, setting them all to the same expanded or 
collapsed state. If there is a mixture of collapsed and expanded nodes, all nodes will be 
expanded. 

Stop Outlining Stops code outlining and remove all outlining information from source files. 

Start Automatic Out-
lining

Starts automatic code outlining and automatically displayed in supported source files. 

Advanced Displays a cascading menu for performing an advanced operation for the Editor panel. 
Note that these items are disabled when this panel is in the mixed display mode.

Increase Line Indent Increases the indentation of the current cursor line by one tab. 

Decrease Line Indent Decreases the indentation of the current cursor line by one tab. 

Uncomment Lines Removes the first set of line-comment delimiters from the start of the current cursor line, 
appropriate to the current language. This operation will only be available when the lan-
guage of the current source file has line-comment delimiters specified. 

Comment Lines Places line-comment delimiters at the start of the current cursor line, appropriate to the 
current language. This operation will only be available when the language of the current 
source file has line-comment delimiters specified. 

Convert Tabs to 
Spaces

Converts all tabs on the current cursor line into spaces. 

Convert Spaces to 
Tabs

Converts each set of consecutive space characters on the current line to tab characters, 
but only for those sets of spaces that are at least equal to one tab size. 

Tabify Selected Lines Tabifies the current line, causing all spaces at the start of the line (prior to any text) to be 
converted to tabs where possible. 
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[[Window] menu (Editor panel-dedicated items)]

The following items are exclusive for the [Window] menu in the Editor panel (other items are common to all the panels). 

[Context menu]

(1)Titlebar area
(2)Coverage area
(3)Event area
(4)Main area (when connected to the debug tool)
(5)Characters area (when disconnected from the debug tool)
(6)Characters area (when connected to the debug tool)

Remark For details on how to set various events when connected to the debug tool, see "CS+ Integrated Devel-
opment Environment User's Manual: Debug Tool". 

(1) Titlebar area

Untabify Selected 
Lines

Untabifies the current line, causing all tabs at the start of the line (prior to any text) to be 
converted to spaces. 

Make Uppercase Converts all letters within the selection to uppercase. 

Make Lowercase Converts all letters within the selection to lowercase. 

Toggle Character 
Casing

Toggles the character cases (uppercase / lowercase) of all letters within the selection. 

Capitalize Capitalizes the first character of every word within the selection. 

Delete Horizontal 
Whitespace

Deletes any excess white space either side of the cursor position, leaving only one 
whitespace character remaining. If there the cursor is within a word or not surrounded by 
whitespace, this operation will have no effect. 

Trim Trailing 
Whitespace

Deletes any trailing whitespace that appears after the last non-whitespace character on 
the cursor line. 

Delete Line Completely delete the current cursor line. 

Duplicate Line Duplicates the cursor line, inserting a copy of the line immediately after the cursor line. 

Delete Blank Lines Deletes the line at the cursor if it is empty or contains only whitespace. 

Line Move Up Moves the current cursor line up.

Line Move Down Moves the current cursor line down.

Split Splits the active Editor panel horizontally.
Only the active Editor panel can be split. Other panels will not be split. A panel can be split 
up to four times.

Remove Split Removes the split view of the Editor panel.

Close Panel Closes the currently selected panel.

Close All but This Closes all other panels being displayed in the same panel display area as the selected 
panel, except for the currently selected panel. 

Floating Displays the Editor panel in a new floating window.
Select [Docking] from the context menu to return the Editor panel to the docking state.
Either [Floating] or [Docking] is displayed.

Docking The Editor panel displayed in a floating window is returned to the docking state.
Either [Floating] or [Docking] is displayed.

Save file name Saves the contents of the opened text file.
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Caution 1. The Editor panel displayed in a floating window is not displayed in the list of windows in the [Win-
dow] menu. Switching by the [Ctrl] + [Tab] key, [Shift] + [Ctrl] + [Tab] key, [Ctrl] + [F6] key, or [Shift] + 
[Ctrl] + [F6] key is also not supported.

Caution 2. During floating, except for [Close Panel] and [Docking], items in the above table are not displayed.

Remark Double-clicking on the title bar during floating switches the maximization level.

(2) Coverage area 

(3) Event area

Copy FUll Path Copies the full path of the opened text file to the clipboard.

Open Containing 
Folder

Opens the folder where the text file is saved in Explorer. 

New Horizontal Tab 
Group

The area for the display of active panels is evenly divided into two areas in the hori-
zontal direction, and the panels are displayed as a new group of tabbed pages. Only 
one panel is active in the new group. The area may be divided into up to four panels.
This item is not displayed in the following cases.

- Only one panel is open.

- The group has already been divided in the vertical direction.

- The group has already been divided into four panels.

New Vertical Tab 
Group

The area for the display of active panels is evenly divided into two areas in the vertical 
direction, and the panels are displayed as a new group of tabbed pages. Only one 
panel is active in the new group. The area may be divided into up to four panels.
This item is not displayed in the following cases.

- Only one panel is open.

- The group has already been divided in the horizontal direction.

- The group has already been divided into four panels.

Go to Next Tab Group When the display area is divided in the horizontal direction, this moves the displayed 
panel to the group under that displaying the selected panel.
When the display area is divided in the vertical direction, this moves the displayed 
panel to the group to the right of that displaying the selected panel.
This item is not displayed if there is no group in the given direction.

Go to Previous Tab 
Group

When the display area is divided in the horizontal direction, this moves the displayed 
panel to the group over that displaying the selected panel.
When the display area is divided in the vertical direction, this moves the displayed 
panel to the group to the left of that displaying the selected panel.
This item is not displayed if there is no group in the given direction.

Clear Coverage Infor-
mation

Clears all the coverage measurement results currently being stored in the debug tool.
Note that this item is enabled only when the selected debug tool supports the cover-
age function. 

Set Timer Start Event Sets a timer start event to start measuring the execution time of the program when the 
line at caret is executed.

Set Timer End Event Sets a timer end event to stop measuring the execution time of the program when the 
line at caret is executed.

Start Performance 
Measurement
[RH850 
[E1][E20][Full-spec 
emulator]]

Sets a performance measurement start event to start measuring the performance 
when the line at caret is executed.
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Note [RH850 [E1][E20]][[RX/RL78 [E1][E20][EZ Emulator]][RL78 [COM Port]]
This item is displayed only when the selected microcontroller incorporates the OCD trace function.

(4) Main area (when connected to the debug tool)

Stop Performance 
Measurement
[RH850 
[E1][E20][Full-spec 
emulator]]

Sets a performance measurement end event to stop measuring the performance 
when the line at caret is executed.

Set Trace Start Event Sets a trace start event to start collecting the trace data when the line at the caret is 
executedNote.

Set Trace End Event Sets a trace end event to stop collecting the trace data when the line at the caret is 
executedNote.

Register Action 
Event...

Opens the Action Events dialog box to set an action event to the corresponding 
address of the line at the caret position.

Enable Event(s) Changes the state of a selected event to a valid state. 
If the event mark (  ) which indicates that multiple events have been set is selected, 
all of the events that have been set are enabled.

Disable Event(s) Changes the state of a selected event to an Invalid state.
If the event mark (  ) which indicates that multiple events have been set is selected, 
all of the events that have been set are disabled.

Delete Event(s) Deletes a selected event.
If the event mark (  ) which indicates that multiple events have been set is selected, 
all of the events that have been set are deleted.

View Details in Event 
Panel

Opens the Event panel to display the detailed information of the selected event.

Set Breakpoint Sets a breakpoint to the line at the caret positionNote.
If a breakpoint is already being set to the line, then the breakpoint will be deleted. 

Set Hardware Break-
point
(except [Simulator])

Sets a breakpoint (Hardware Break event) to the line at the caret position.

Set Software Break-
point
(except [Simulator])

Sets a breakpoint (Software Break event) to the line at the caret position.

Hardware Break First
(except [Simulator])

The type of break that can be set by a one click operation of the mouse is set as a 
hardware breakpoint (this is reflected in the setting of the [First using type of break-
point] property in the [Break] category from the [Debug Tool Settings] tab on the Prop-
erty panel).

Software Break First
(except [Simulator])

The type of break that can be set by a one click operation of the mouse is set as a soft-
ware breakpoint (this is reflected in the setting of the [First using type of breakpoint] 
property in the [Break] category from the [Debug Tool Settings] tab on the Property 
panel).

Enable Breakpoint Changes the selected breakpoint state to a valid state.
If the event mark (  ) which indicates that multiple events have been set is selected, 
all of the breakpoints that have been set are enabled. 

Disable Breakpoint Changes the selected breakpoint state to an invalid state.
If the event mark (  ) which indicates that multiple events have been set is selected, 
all of the breakpoints that have been set are disabled. 

Delete Breakpoint Deletes the selected breakpoint.
If the event mark (  ) which indicates that multiple events have been set is selected, 
all of the breakpoints that have been set are deleted.
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Note Except for [Simulator]
By default, the debug tool will set a hardware break when resources are available. 
This behavior can be customized by using the [Hardware Break First] or [Software Break First] 
menu items.

(5) Characters area (when disconnected from the debug tool)

View Details in Event 
Panel

Opens the Events panel to display the detailed information of the selected event.

Cut Cuts the selected character string and copies it to the clipboard. 
If there is no selection, the entire line is cut. 

Copy Copies the contents of the selected range to the clipboard as character string(s). 
If there is no selection, the entire line is copied. 

Paste Inserts (insert mode) or overwrites (overwrite mode) the characters that are copied on 
the clip board into the caret position. 
When the contents of the clipboard are not recognized as characters, the operation is 
invalid.

Find... Opens the Find and Replace dialog box with selecting [Quick Find] tab . 

Go To... Opens the Go to Line dialog box  to move the caret to the specified line. 

Forward To Next Cur-
sor Position

Forwards to the position before operating [Back To Last Cursor Position].

Back To Last Cursor 
Position

Goes back to the position before operating [Jump to Function or Variable]/[Find...]/[Go 
To...]/[Next Bookmark]/[Previous Bookmark] or moving the caret by clicking the 
mouse. 
The jump history is cleared when all of the Editor panel currently being opened are 
closed. 

Jump to Function or 
Variable

Jumps to the function or the variable that is selected or at the caret position regarding 
the selected characters and the words at the caret position as functions or variables 
(see "2.6Jump to Functions or Variables").

Tag Jump Jumps to the corresponding line and column in the corresponding file if the information 
of a file name, a line number and a column number exists in the line at the caret posi-
tion (see "2.7Jump to a Desired Line (Tag Jump)"). 

Bookmark Displays a cascading menu for bookmarks (see "2.8Register Bookmarks"). 

Toggle Bookmark Inserts/deletes a bookmark on the line at the current caret position.

Next Bookmark Moves a caret to the position of the next bookmark, in the active Editor panel.
Note that this item is disabled in the following cases: 

- No bookmark is registered.

- A bookmark is registered only in one line with a caret.

Previous Bookmark Moves a caret to the position of the previous bookmark, in the active Editor panel.
Note that this item is disabled in the following cases: 

- No bookmark is registered.

- A bookmark is registered only in one line with a caret.

Clear All Bookmarks Clears all the registered bookmarks, in the active Editor panel. 
Note that this item is disabled when no bookmark is registered. 

List Bookmarks... Opens the Bookmarks dialog box for displaying the list of bookmarks.
Note that this item is disabled when the project is closed. 

Advanced Displays a cascading menu for performing an advanced operation for the Editor panel. 
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(6) Characters area (when connected to the debug tool)

Increase Line Indent Increases the indentation of the current cursor line by one tab. 

Decrease Line 
Indent

Decreases the indentation of the current cursor line by one tab. 

Uncomment Lines Removes the first set of line-comment delimiters from the start of the current cursor 
line, appropriate to the current language. This operation will only be available when 
the language of the current source file has line-comment delimiters specified. 

Comment Lines Places line-comment delimiters at the start of the current cursor line, appropriate to 
the current language. This operation will only be available when the language of the 
current source file has line-comment delimiters specified. 

Convert Tabs to 
Spaces

Converts all tabs on the current cursor line into spaces. 

Convert Spaces to 
Tabs

Converts each set of consecutive space characters on the current line to tab charac-
ters, but only for those sets of spaces that are at least equal to one tab size. 

Tabify Selected 
Lines

Tabifies the current line, causing all spaces at the start of the line (prior to any text) to 
be converted to tabs where possible. 

Untabify Selected 
Lines

Untabifies the current line, causing all tabs at the start of the line (prior to any text) to 
be converted to spaces. 

Make Uppercase Converts all letters within the selection to uppercase. 

Make Lowercase Converts all letters within the selection to lowercase. 

Toggle Character 
Casing

Toggles the character cases (uppercase / lowercase) of all letters within the selection. 

Capitalize Capitalizes the first character of every word within the selection. 

Delete Horizontal 
Whitespace

Deletes any excess white space either side of the cursor position, leaving only one 
whitespace character remaining. If there the cursor is within a word or not surrounded 
by whitespace, this operation will have no effect. 

Trim Trailing 
Whitespace

Deletes any trailing whitespace that appears after the last non-whitespace character 
on the cursor line. 

Delete Line Completely delete the current cursor line. 

Duplicate Line Duplicates the cursor line, inserting a copy of the line immediately after the cursor line. 

Delete Blank Lines Deletes the line at the cursor if it is empty or contains only whitespace. 

Line Move Up Moves the current cursor line up.

Line Move Down Moves the current cursor line down.

Register to Watch1 Registers a selected character string or a word at the caret position to the Watch 
panel (Watch1) as a watch-expression (the judgment of the word depends on current 
build tool).
Note that this item is disabled when no corresponding address exists in the line at 
caret. 

Register to Analysis 
Chart

Registers a selected character string or a word at the caret position to the Analysis 
Chart panel of the analyze tool (Program Analyzer) as a variable.  If variables have 
been already registered to all channels, a message is displayed and this operation 
will have no effect. 
Note that this item is disabled when the active project does not support a plug-in of 
the analyze tool. 
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Register Action Event... Opens the Action Events dialog box to set an action event to the corresponding 
address of the line at the caret position. 
Note that this item is disabled when no corresponding address exists in the line at 
caret. 

Cut Deletes the selected character string(s) and copies them to the clipboard. 
If there is no selection, the entire line is cut. 
Note that this item is disabled when this panel is in the mixed display mode.

Copy Copies the contents of the selected range to the clipboard as character string(s). 
If there is no selection, the entire line is copied. 

Paste Inserts (insert mode) or overwrites (overwrite mode) the characters that are copied 
on the clip board into the caret position. 
Note that this item is disabled when the contents of the clipboard are not recognized 
as characters or this panel is in the mixed display mode.

Find... Opens the Find and Replace dialog box with selecting [Quick Find] tab . 

Go To... Opens the Go to Line dialog box  to move the caret to the specified line. 

Forward To Next Cursor 
Position

Forwards to the position before operating [Back To Last Cursor Position]. 
Note that this item is disabled when this panel is in the mixed display mode.

Back To Last Cursor 
Position

Goes back to the position before operating [Jump to Function or Variable]/[Find...]/
[Go To...]/[Next Bookmark]/[Previous Bookmark] or moving the caret by clicking the 
mouse. 
The jump history is cleared when all of the Editor panel currently being opened are 
closed. 
Note that this item is disabled when this panel is in the mixed display mode.

Go to Here Executes the program from the address indicated by the current PC value to the 
address corresponding to the line at the caret position. 
Note that this item is disabled during program execution/build (not including rapid 
build) execution.

Set PC to Here Sets the address of the line at the current caret position to the current PC value. 
Note that this item is disabled when no corresponding address exists in the line at 
caret, or during program execution/build (not including rapid build) execution

Jump to Function or 
Variable

Jumps to the function or the variable that is selected or at the caret position regarding 
the selected characters and the words at the caret position as functions or variables 
(see "2.6Jump to Functions or Variables").

Tag Jump Jumps to the corresponding line and column in the corresponding file if the informa-
tion of a file name, a line number and a column number exists in the line at the caret 
position (see "2.7Jump to a Desired Line (Tag Jump)"). 

Jump to Disassemble Opens the Disassemble panel and jumps to the address corresponding to the line at 
the caret. 
Note that this item is disabled when no corresponding address exists in the line at 
caret. 
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Bookmark Displays a cascading menu for bookmarks (see "2.8Register Bookmarks"). 

Toggle Bookmark Inserts/deletes a bookmark on the line at the current caret position.
Note that this item is disabled when this panel is in the mixed display mode.

Next Bookmark Moves a caret to the position of the next bookmark, in the active Editor panel.
Note that this item is disabled in the following cases: 

- No bookmark is registered.

- A bookmark is registered only in one line with a caret.

- This panel is in the mixed display mode. 

Previous Bookmark Moves a caret to the position of the previous bookmark, in the active Editor panel.
Note that this item is disabled in the following cases: 

- No bookmark is registered.

- A bookmark is registered only in one line with a caret.

- This panel is in the mixed display mode. 

Clear All Bookmarks Clears all the registered bookmarks, in the active Editor panel. 
Note that this item is disabled in the following cases: 

- No bookmark is registered.

- This panel is in the mixed display mode. 

List Bookmarks... Opens the Bookmarks dialog box for displaying the list of bookmarks.
Note that this item is disabled when the project is closed. 

Advanced Displays a cascading menu for performing an advanced operation for the Editor 
panel. 
Note that these items are disabled when this panel is in the mixed display mode.

Increase Line Indent Increases the indentation of the current cursor line by one tab. 

Decrease Line 
Indent

Decreases the indentation of the current cursor line by one tab. 

Uncomment Lines Removes the first set of line-comment delimiters from the start of the current cursor 
line, appropriate to the current language. This operation will only be available when 
the language of the current source file has line-comment delimiters specified. 

Comment Lines Places line-comment delimiters at the start of the current cursor line, appropriate to 
the current language. This operation will only be available when the language of the 
current source file has line-comment delimiters specified. 

Convert Tabs to 
Spaces

Converts all tabs on the current cursor line into spaces. 

Convert Spaces to 
Tabs

Converts each set of consecutive space characters on the current line to tab charac-
ters, but only for those sets of spaces that are at least equal to one tab size. 

Tabify Selected 
Lines

Tabifies the current line, causing all spaces at the start of the line (prior to any text) to 
be converted to tabs where possible. 

Untabify Selected 
Lines

Untabifies the current line, causing all tabs at the start of the line (prior to any text) to 
be converted to spaces. 

Make Uppercase Converts all letters within the selection to uppercase. 

Make Lowercase Converts all letters within the selection to lowercase. 

Toggle Character 
Casing

Toggles the character cases (uppercase / lowercase) of all letters within the selec-
tion. 

Capitalize Capitalizes the first character of every word within the selection. 



CS+ V8.06.00 A.  WINDOW REFERENCE

R20UT4972EJ0100  Rev.1.00 Page 44 of 78
Jun 01, 2021

Delete Horizontal 
Whitespace

Deletes any excess white space either side of the cursor position, leaving only one 
whitespace character remaining. If there the cursor is within a word or not sur-
rounded by whitespace, this operation will have no effect. 

Trim Trailing 
Whitespace

Deletes any trailing whitespace that appears after the last non-whitespace character 
on the cursor line. 

Delete Line Completely delete the current cursor line. 

Duplicate Line Duplicates the cursor line, inserting a copy of the line immediately after the cursor 
line. 

Delete Blank Lines Deletes the line at the cursor if it is empty or contains only whitespace. 

Line Move Up Moves the current cursor line up.

Line Move Down Moves the current cursor line down.

Break Settings The following cascade menus are displayed to set the break-related event. 

Set Hardware Break Sets a breakpoint (Hardware Break event) to the line at the caret position. 

Set Software Break
(except [Simulator])

Sets a breakpoint (Software Break event) to the line at the caret position. 

Set Combination 
Break

Sets a break event (execution type) to the line at the caret position as one of the con-
dition for a Combination Break eventNote 1. 

Set Read Break to Sets a break event with read access condition to the line at the caret or the selected 
variable (global variable, static variable inside functions, or file-internal static vari-
able)/I/O register [RH850][RX]/SFR [RL78]Note 2. 

Set Write Break to Sets a break event with write access condition to the line at the caret or the selected 
variable (global variable, static variable inside functions, or file-internal static vari-
able)/I/O register [RH850][RX]/SFR [RL78]Note 2. 

Set R/W Break to Sets a break event with read/write access condition to the line at the caret or the 
selected variable (global variable, static variable inside functions, file-internal static 
variable)/I/O register [RH850][RX]/SFR [RL78]Note 2. 

Set Read Combina-
tion Break to

Sets a break event with read access condition to the line at the caret or the selected 
variable (global variable, static variable inside functions, or file-internal static vari-
able)/SFR as one of the condition for a Combination Break eventNote 1. 

Set Write Combina-
tion Break to

Sets a break event with write access condition to the line at the caret or the selected 
variable (global variable, static variable inside functions, or file-internal static vari-
able)/SFR as one of the condition for a Combination Break eventNote 1. 

Set R/W Combina-
tion Break to

Sets a break event with read/write access condition to the line at the caret or the 
selected variable (global variable, static variable inside functions, file-internal static 
variable)/SFR as one of the condition for a Combination Break eventNote 1. 

Break Option Opens the Property panel to set the break function. 

Trace Settings The following cascade menus are displayed to set the trace-related eventNote 3. 
Note that this item is enabled only when both the selected microcontroller and debug 
tool support the trace function. 
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Start Tracing Sets a trace start event to start collecting the trace data when the line at the caret is 
executed.

Stop Tracing Sets a trace end event to stop collecting the trace data when the line at the caret is 
executed. 

Record Reading 
Value

Sets a Point Trace event to record the access value as the trace data when a vari-
able at the caret or the selected variable (global variable, static variable inside func-
tions, file-internal static variable) /I/O register [RH850][RX]/SFR [RL78] is read 
accessed.

Record Writing 
Value

Sets a Point Trace event to record the access value as the trace data when a vari-
able at the caret or the selected variable (global variable, static variable inside func-
tions, file-internal static variable) /I/O register [RH850][RX]/SFR [RL78] is write 
accessed.

Record R/W Value Sets a Point Trace event to record the access value as the trace data when a vari-
able at the caret or the selected variable (global variable, static variable inside func-
tions, file-internal static variable) /I/O register [RH850][RX]/SFR [RL78] is read/ write 
accessed.

Record Start R/W 
Value

Sets a trace start event to start collecting the trace data when a variable at the caret 
or the selected variable (global variable, static variable inside functions, file-internal 
static variable) /I/O register [RH850][RX]/SFR [RL78] is read/ write accessed.
Note that this item is enabled only when both the selected microcontroller and debug 
tool support this function. 

Record End R/W 
Value

Sets a trace end event to stop collecting the trace data when a variable at the caret 
or the selected variable (global variable, static variable inside functions, file-internal 
static variable) /I/O register [RH850][RX]/SFR [RL78] is read/ write accessed.
Note that this item is enabled only when both the selected microcontroller and debug 
tool support this function. 

Show Trace Result Opens the Trace panel and displays the acquired trace data. 

Trace Settings Opens the Property panel to set the trace function. 
Note that this item is disabled the trace function is in operation.

Timer Settings The following cascade menus are displayed to set the timer-related eventNote 4.
Note that this item is enabled only when both the selected microcontroller and debug 
tool support the timer function.

Start timer Sets a timer start event to start measuring the execution time of the program when an 
instruction of an address at the caret position is executed.

Set Timer n Specify a channel nNote 5 in which a timer start event is set.
Note that this item is enabled only when both the selected microcontroller and debug 
tool support this function.

Stop timer Sets a timer end event to stop measuring the execution time of the program when an 
instruction of an address at the caret position is executed.

Set Timer n Specify a channel nNote 5 in which a timer end event is set.
Note that this item is enabled only when both the selected microcontroller and debug 
tool support this function.

Set Timer Start R/W 
Value

Sets a timer start event that causes a measurement of the program's execution time 
to start upon read/write access to the caret position or a selected variable (global 
variable, static variable inside a function, static variable inside a file) or I/O register 
[RH850][RX]/SFR [RL78].
Note that this item is enabled only when both the selected microcontroller and debug 
tool support this function.

Set Timer n Specify a channel nNote 5 in which a timer start event is set.



CS+ V8.06.00 A.  WINDOW REFERENCE

R20UT4972EJ0100  Rev.1.00 Page 46 of 78
Jun 01, 2021

Set Timer End R/W 
Value

Sets a timer end event that causes a measurement of the program's execution time 
to finish upon read/write access to the caret position or a selected variable (global 
variable, static variable inside a function, static variable inside a file) or I/O register 
[RH850][RX]/SFR [RL78].
Note that this item is enabled only when both the selected microcontroller and debug 
tool support this function.

Set Timer n Specify a channel nNote 5 in which a timer end event is set.

View Result of Timer Opens the Events panel and displays only timer-related events. 

Performance 
Measurement Settings
[Full-spec emulator] 
[E1/E20 [RH850]]

The following cascade menus are displayed to set the event related to performance 
measurement.

Start Performance 
Measurement

Sets a performance measurement start event to start measuring performance mea-
surement when the instruction of the address at the caret position is executed.

Set Performance 
Measurement n

Specify a channel nNote 6 (n: 1 to 3) in which a performance measurement start event 
is set.

Stop Performance 
Measurement

Sets a performance measurement end event to stop measuring performance mea-
surement when the instruction of the address at the caret position is executed.

Set Performance 
Measurement n

Specify a channel nNote 6 (n: 1 to 3) in which a performance measurement end event 
is set.

Set Performance 
Measurement Start 
Read Value

Sets a performance measurement start event that causes performance measure-
ment to start upon read access to the caret position or a selected variable (global 
variable, static variable inside a function, static variable inside a file) or I/O register.

Set Performance 
Measurement n

Specify a channel nNote 6 (n: 1 to 3) in which a performance measurement start event 
is set.

Set Performance 
Measurement End 
Read Value

Sets a performance measurement end event that causes performance measurement 
to end upon read access to the caret position or a selected variable (global variable, 
static variable inside a function, static variable inside a file) or I/O register.

Set Performance 
Measurement n

Specify a channel nNote 6 (n: 1 to 3) in which a performance measurement end event 
is set.

Set Performance 
Measurement Start 
Write Value

Sets a performance measurement start event that causes performance measure-
ment to start upon write access to the caret position or a selected variable (global 
variable, static variable inside a function, static variable inside a file) or I/O register.

Set Performance 
Measurement n

Specify a channel nNote 6 (n: 1 to 3) in which a performance measurement start event 
is set.

Set Performance 
Measurement End 
Write Value

Sets a performance measurement end event that causes performance measurement 
to end upon write access to the caret position or a selected variable (global variable, 
static variable inside a function, static variable inside a file) or I/O register.

Set Performance 
Measurement n

Specify a channel nNote 6 (n: 1 to 3) in which a performance measurement end event 
is set.

Set Performance 
Measurement Start 
R/W Value

Sets a performance measurement start event that causes performance measure-
ment to start upon read/write access to the caret position or a selected variable 
(global variable, static variable inside a function, static variable inside a file) or I/O 
register.

Set Performance 
Measurement n

Specify a channel nNote 6 (n: 1 to 3) in which a performance measurement start event 
is set.

Set Performance 
Measurement End 
R/W Value

Sets a performance measurement end event that causes performance measurement 
to end upon read/write access to the caret position or a selected variable (global vari-
able, static variable inside a function, static variable inside a file) or I/O register.
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Note 1. This item is enabled only when both the selected microcontroller and debug tool support a Combi-
nation Break event.

Note 2. This item is disabled when both the selected microcontroller and debug tool support a Combination 
Break event (i.e. this item is not shown). 

Note 3. [Simulator]
When a trace-related event is set, the [Use trace function] property in the [Trace] category on the 
[Debug Tool Settings] tab of the Property panel is automatically set to [Yes]. 

Note 4. [Simulator]
When a timer-related event is set, the [Use timer function] property in the [Timer] category on the 
Property panel is automatically set to [Yes]. 

Note 5. The specifiable number of channels differs with the selected microcontroller. 
For details on the timer function, see "CS+ Integrated Development Environment User's Manual: 
Debug Tool".

Note 6. [RH850 [E1][E20][Full-spec emulator]]
The specifiable number of channels differs with the selected microcontroller. 
For details on the performance measurement function, see "CS+ Integrated Development Environ-
ment User's Manual: Debug Tool".

Note 7. Setting of monitor points for current is only possible when you are using an E2 emulator as the 
debug tool and an MCU other than the RL78/G10.

Set Performance 
Measurement n

Specify a channel nNote 6 (n: 1 to 3) in which a performance measurement end event 
is set.

View Result of 
Performance 
Measurement

Opens the Events panel and displays events related to performance measurement.

Clear Coverage Infor-
mation

Clears all the coverage measurement results currently being stored in the debug tool.
Note that this item is enabled only when the selected debug tool supports the cover-
age function.

Set Measuring CAN 
Bus Reception Pro-
cessing Time
[E2 emulator [RH850]]

Displays a cascade menus for inserting a dbtag instruction for measuring the CAN 
bus reception processing time.

Set DBTAG insertion 
point

Displays a menus for setting an insertion point for a dbtag instruction.

Insert 
DBTAG(DBTAG 
value)

Sets an insertion point for a dbtag instruction to output DBTAG value at the caret 
position.
DBTAG value can be 0x21, 0x29, 0x31, 0x39, 0x41, 0x49, 0x51, 0x59, 0x61, or 0x69.

Delete insertion 
point for DBTAG

Deletes the insertion point for a dbtag instruction at the caret position.

Monitor Point Setting
[RL78]Note 7

Displays a cascade menus for setting a monitor point for measurement of the current 
consumption.

Enable Monitor 
Point

Enables the monitor point at the caret position.

Disable Monitor 
Point

Disables the monitor point at the caret position.

Set Monitor Point Set a monitor point at the caret position.

Delete Monitor Point Deletes the monitor point at the caret position.

Save Source Mixed 
Data As...

Opens the Save As dialog box to newly save the contents of the currently editing Edi-
tor panel. 
Note that this item is enabled only when the Editor panel is in the mixed display 
mode. 
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This dialog box is used to select a file-encoding.

Figure A.6 Encoding Dialog Box

This section describes the following.  

- [How to open]

- [Description of each area]

- [Function buttons]

[How to open]

- From the [File] menu, open the Open File dialog box by selecting [Open with Encoding...], and then click the [Open] 
button in the dialog box.

[Description of each area]

(1) [Available encodings]
Select the encoding to be set.
The encoding of the selected file is selected by default.

[Function buttons]

Encoding dialog box

Button Function

OK Opens the selected file in the Open File dialog box using a selected file encoding.

Cancel Not open the selected file in the Open File dialog box and closes this dialog box.

Help Displays the help for this dialog box. 

(1)

[Function buttons]
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This dialog box is used to specify the encoding and the new line code of the file being edited in the Editor panel. 

Figure A.7 Save Settings Dialog Box 

Remark The target file name is displayed on the title bar.

This section describes the following. 

- [How to open]

- [Description of each area]

- [Function buttons]

[How to open]

- With the Editor panel in focus, select [File name Save Settings...] from the [File] menu.

[Description of each area]

(1) [Encode] area
Select the encoding to be set from the drop-down list.
The items of the drop-down list are displayed according to the following sequence.
Note that the same encoding and encoding which are not supported by the current OS will not be displayed.

- Current encoding of the file (default)

- Default encoding of the current OS

- Most recently used encodings (maximum 4)

- Popular encodings for current locale
(e.g. for United States locale it will be:

- Western European (Windows)

- Unicode (UTF-8) 

- All other encodings supported by the OS (in alphabetical order)

(2) [New line code] area
Select the new line code to be set from the drop-down list. 
Either of the following can be selected. 

- Windows (CR LF)

- Macintosh (CR)

- Unix (LF)
An active newline entry is selected by default.

Save Settings dialog box

(1)

[Function buttons]

(2)

(3)
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(3) [Reload the file with these settings] 

[Function buttons]

Reloads the file with the specified encoding and new line code when the [OK] button is clicked. 

Does not reload the file when the [OK] button is clicked (default). 

Button Function

OK Sets the selected encoding and newline code to the target file and closes this dialog box. 
If [Reload the file with these settings] is selected, sets the selected encoding and newline 
code to the target file and reloads the file. And then closes this dialog box. 

Cancel Cancels the setting and closes this dialog box.  

Help Displays the help for this dialog box.  
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This dialog box is used to find and replace the designated characters.

Figure A.8 Find and Replace Dialog Box

Remark The  button in [Search text] will be displayed only if this dialog box is opened from the Editor panel.

The following items are explained here.

- [How to open]

- [Description of each area]

- [Function buttons]

[How to open]

- From the [Edit] menu, select [Find...].

- From the [Edit] menu, select [Replace...].

[Description of each area]

(1) Tab selection area
Find/replace is switched when a tab is selected.
This dialog box has the following tabs.

- [Quick Find] tab

- [Find in Files] tab

- [Quick Replace] tab

- [Replace in Files] tab

(2) Search/replace criteria setting area
Detailed criteria for searching/replacing is set.
Please see the description of the relevant tabs for details of the contents/how to set.

[Function buttons]

Buttons for execute find/replace.
Please see the description of the relevant buttons for details.

Find and Replace dialog box

(2)

(1)

[Function buttons]
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[Quick Find] tab

This tab finds the designated characters and moves the caret to the searched position with the position being selected.

Figure A.9 Find and Replace Dialog Box: [Quick Find] Tab

Remark 1. This tab is enabled only when the Find and Replace dialog box is called from the Property panel, Output 
panel, or Editor panel.

Remark 2. The  button in [Search text] area will be displayed only if this dialog box is opened from the Editor 
panel.

The following items are explained here.

- [How to open]

- [Description of each area]

- [Function buttons]

[How to open]

- From the [Edit] menu, select [Find...].

- From the [Edit] menu, select [Replace...].

[Description of each area]

(1) [Search text] area
Designate characters to find.
You can directly enter the characters into the text box (maximum characters: 1024) or select from the input history 
in the drop-down list (up to 10 history entries).
By default, a word (including a variable, function, etc.) at the caret position is shown.  Note, however, that if this 
dialog box is opened from the panel with the character being selected, the selected characters are shown by 
default.

You can select the following wildcard by using the  button. This is available when this dialog box is opened 
from the Editor panel and "Wild-card" is selected in [Search criteria].

- # Any single digit

- * Zero or more of any character

- ?  Any single character

- [!] Any one character not in the set

- [] Any one character in the set

(4)

(1)

[Function buttons]

(2)

(3)
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You can select the following regular expressions by using the  button. This is available when this dialog box is 
opened from the Editor panel and "Regular Expression" is selected in [Search criteria].

- $ End of line

- ( ) Group capture

- * Zero or more

- + One or more

- . Any single character

- [] Any one character not in the set

- [^] Any one character not in the set

- \ Escape special character

- \b Word boundary

- \n Line break

- \s Whitespace

- ^ Beginning of line

- | Or

Remark For details on regular expressions, see "B.REGULAR EXPRESSIONS SYNTAX".

(2) [Replace with] area
This item is disabled.

(3) [Search location] area
Designate the location to find.
Select one of the following items from the drop-down list.

Remark Up to 10 history entries are recorded in the drop-down list.

(4) [Option] area
This area is shown when the [Option] button is clicked (not shown by default).
The following options can be designated as search criteria.

(a) [Search criteria]
Select one of the following items from the drop-down list.

Note This item is enabled only when the Editor panel is focused.

(b) [File type]
This item is disabled.

(c) [Match case]

Item Operation

Selection area Finds the selection in the search enabled panel which was active the last 
time.
If this dialog box is opened from the Editor panel, or if there is no charac-
ters in selection in the panel which was last active, or the panel cannot be 
found, this item will be disabled.

Current document (Panel Name) Finds in the panel which was last active and can be found.
If the panel which was lastly active cannot be found or the panel does not 
exist, this item will be disabled.

Item Operation

Normal Finds the characters designated in [Search text] area.

Wild-card Finds using the wildcard designated in [Search text] area.

Regular ExpressionsNote Finds using the regular expressions designated in [Search text] area.

Finds the designated characters in case-sensitive.
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(d) [Match whole word]

(e) [Open file before replacing]
This item is disabled.

[Function buttons]

Note If the designated characters cannot be searched, "Search text was not found." is displayed on the status 
bar of the Main window.

Finds the designated characters in not case-sensitive (default).

Finds a designated exact word.

Finds at least one of the words (default).

Button Function

Option Switches between display/hide the [Option] area in this tab.

Find Previous Finds from the current caret position to the top of the file with the designated cri-
teria.  Selects the characters that are searched and moves the caretNote.
The operation is the same as when the [Shift] + [Enter] key is pressed.

Find Next Finds from the current caret position to the end of the file with the designated cri-
teria.  Selects the characters that are searched and moves the caretNote.
The operation is the same as when the [Enter] key is pressed.

Cancel Ignores the setting and closes this dialog box.

Help Displays the help of this dialog box
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[Find in Files] tab

In this tab, the designated characters are found in batch and the search results are listed in the Output panel.
The Output panel is used to jump to the relevant location by double-clicking the search result.

Figure A.10 Find and Replace Dialog Box: [Find in Files] Tab

Remark The  button in [Search text] area will be displayed only if this dialog box is opened from the Editor 
panel.

The following items are explained here.

- [How to open]

- [Description of each area]

- [Function buttons]

[How to open]

- From the [Edit] menu, select [Find...].

- From the [Edit] menu, select [Replace...].

[Description of each area]

(1) [Search text] area
Designate characters to find.
You can directly enter the characters into the text box (maximum characters: 1024) or select from the input history 
in the drop-down list (up to 10 history entries).
By default, a word (including a variable, function, etc.) at the caret position is shown.  Note, however, that if this 
dialog box is opened from the panel with the character being selected, the selected characters are shown by 
default.

You can select the following wildcard by using the  button. This is available when this dialog box is opened 
from the Editor panel and "Wild-card" is selected in [Search criteria].

- # Any single digit

- * Zero or more of any character

- ?  Any single character

- [!] Any one character not in the set

- [] Any one character in the set

You can select the following regular expressions by using the  button. This is available when this dialog box is 
opened from the Editor panel and "Regular Expression" is selected in [Search criteria].

(4)

(1)

[Function buttons]

(2)

(3)
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- $ End of line

- ( ) Group capture

- * Zero or more

- + One or more

- . Any single character

- [] Any one character not in the set

- [^] Any one character not in the set

- \ Escape special character

- \b Word boundary

- \n Line break

- \s Whitespace

- ^ Beginning of line

- | Or

Remark For details on regular expressions, see "B.REGULAR EXPRESSIONS SYNTAX".

(2) [Replace with] area
This item is disabled.

(3) [Search location] area
Designate the location to search.
Select either one of the following items from the drop-down list or directly enter the file location from the keyboard 
(maximum number: 10).

Remark Up to 10 history entries are recorded in the drop-down list.

(4) [Option] area
This area is shown when the [Option] button is clicked (not shown by default).
The following options can be designated as search criteria.

(a) [Search criteria]
Select one of the following items from the drop-down list.

Item Operation

Current document (Panel Name) Finds within the current Editor panel.

All open documents Finds all the opening the Editor panel.
If no file is opened in the Editor panel, this item is disabled.

Active project Finds the text file included in the active project.
When [File type] is specified, searches only the specified type.
Note that is the current project does not exist, this item is disabled.

Main project and subprojects Finds within the text file included in the main project and subproject.
When [File type] is specified, searches only the specified type.
Note that is the current project does not exist, this item is disabled.

Folder Name Finds within the text file in the folder specified by directly entering (the 
maximum characters: 259) the path (relative path is from the project 
folder), or specified in the Browse For Folder dialog box opened by click-
ing the [...] button in this area.  When folders are not specified, the project 
folder name is shown in "( )" by default folder (if the project does not exist, 
the current user document folder is shown).
When [File type] is specified, finds only the specified type.

Item Operation

Normal Finds the characters designated in [Search text] area.

Wild-card Finds using the wildcard designated in [Search text] area.
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Note This item is enabled only when the Editor panel is focused.

(b) [File type]
Specify File types to search.
Select one of the following items from the drop-down list.

Note Show extensions of the source file added to the Project Tree panel.

Note that the searches can be operated by limiting the search criteria by directly entering the file name in the 
text box (maximum characters: 1024).
If this is the case, the wildcard "*" can be used and multiple file names can be specified by separating them with 
";".

Caution If you directly enter terms in this text box, they must consist only of wildcards as the filenames 
and filename extensions.
If you enter "Source files(*.c; *.h)", for example, "Source files(aaa.c" and "Source files(bbb.c", 
and "ccc.h)" will be covered by the search, but "aaa.c", "bbb.c", and "ccc.h" (presumably the 
intention) will not. To find "aaa.c", "bbb.c", and "ccc.h", simply enter "*.c; *.h".

Remark Up to 10 history entries are recorded in the drop-down list.

(c) [Match case]

(d) [Match whole word]

(e) [Open file before replacing]
This item is disabled.

[Function buttons]

Regular ExpressionsNote Finds using the regular expressions designated in [Search text] area.

Item Operation

Source files (ExtensionsNote) Files to find are limited to the source files.

*.txt Files to find are limited to the text files.

*.* Finds all the files.

Finds the designated characters in case-sensitive.

Finds the designated characters in not case-sensitive (default).

Finds a designated exact word.

Finds at least one of the words (default).

Button Function

Option Switches between display/hide the [Option] area in this tab.

Find All Finds characters with designated criteria in batch and shows the search results in 
list in the Output panel.

Cancel Ignores the setting and closes this dialog box.

Help Displays the help of this dialog box.

Item Operation
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[Quick Replace] tab

In this tab, search is done with the designated characters and then they are replaced to the characters to be replaced.

Figure A.11 Find and Replace Dialog Box: [Quick Replace] Tab

Remark This tab is enabled only when the Find and Replace dialog box is called from the Editor panel in the Nor-
mal display mode.

The following items are explained here.

- [How to open]

- [Description of each area]

- [Function buttons]

[How to open]

- From the [Edit] menu, select [Find...].

- From the [Edit] menu, select [Replace...].

[Description of each area]

(1) [Search text] area
Designate characters to find.
You can directly enter the characters into the text box (maximum characters: 1024) or select from the input history 
in the drop-down list (up to 10 history entries).
By default, a word (including a variable, function, etc.) at the caret position is shown.  Note, however, that if this 
dialog box is opened from the panel with the character being selected, the selected characters are shown by 
default.

You can select the following wildcard by using the  button. This is available when "Wild-card" is selected in 
[Search criteria].

- # Any single digit

- * Zero or more of any character

- ?  Any single character

- [!] Any one character not in the set

- [] Any one character in the set

You can select the following regular expressions by using the  button. This is available when "Regular Expres-
sion" is selected in [Search criteria].

- $ End of line

(4)

(1)

[Function buttons]

(2)

(3)
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- ( ) Group capture

- * Zero or more

- + One or more

- . Any single character

- [] Any one character not in the set

- [^] Any one character not in the set

- \ Escape special character

- \b Word boundary

- \n Line break

- \s Whitespace

- ^ Beginning of line

- | Or

Remark For details on regular expressions, see "B.REGULAR EXPRESSIONS SYNTAX".

(2) [Replace with] area
Designate characters to be replaced.
You can directly enter the characters into the text box (maximum characters: 1024) or select from the input history 
in the drop-down list (maximum numbers of the history: 10).

(3) [Search location] area
The following item will appear in the drop-down list.

Remark Up to 10 history entries are recorded in the drop-down list.

(4) [Option] area
This area is shown when the [Option] button is clicked (not shown by default).
The following options can be designated as search criteria.

(a) [Search criteria]
Select one of the following items from the drop-down list.

(b) [File type]
This item is disabled.

(c) [Match case]

(d) [Match whole word]

(e) [Open file before replacing]
This item is disabled.

Item Operation

Current document (Panel Name) Finds in the panel which was last active and can be found.
If the panel which was lastly active cannot be found or the panel does not 
exist, this item will be disabled.

Item Operation

Normal Finds the characters designated in [Search text] area.

Wild-card Finds using the wildcard designated in [Search text] area.

Regular Expressions Finds using the regular expressions designated in [Search text] area.

Finds the designated characters in case-sensitive.

Finds the designated characters in not case-sensitive (default).

Finds with a designated exact word.

Finds with at least one of the words (default).
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[Function buttons]

Note If the designated characters cannot be searched, "Search text was not found." is displayed on the status 
bar of the Main window.

Button Function

Option Switches between display/hide the [Option] area in this tab.

Find Previous Finds from the current caret position to the top of the file with the designated cri-
teria.  Selects the characters that are found and moves the caretNote.

Find Next Finds from the current caret position to the end of the file with the designated cri-
teria.  Selects the characters that are found and moves the caretNote.

Replace and Next
(Replace and Previous)

Replaces the selected characters to the characters to be replaced then searches 
the next (previous) candidate and selects themNote.

Cancel Ignores the setting and closes this dialog box.

Help Displays the help of this dialog box.
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[Replace in Files] tab

In this tab, batch search is done with the designated characters and then they are replaced to the characters to be 
replaced in batch.

Figure A.12 Find and Replace Dialog Box: [Replace in Files] Tab

Remark 1. This tab is enabled only when the Find and Replace dialog box is called from the Editor panel in the Nor-
mal display mode.

Remark 2. The  button in [Search text] area will be displayed only if this dialog box is opened from the Editor 
panel.

The following items are explained here.

- [How to open]

- [Description of each area]

- [Function buttons]

[How to open]

- From the [Edit] menu, select [Find...].

- From the [Edit] menu, select [Replace...].

[Description of each area]

(1) [Search text] area
Designate characters to find.
You can directly enter the characters into the text box (maximum characters: 1024) or select from the input history 
in the drop-down list (up to 10 history entries).
By default, a word (including a variable, function, etc.) at the caret position is shown.  Note, however, that if this 
dialog box is opened from the panel with the character being selected, the selected characters are shown by 
default.

You can select the following wildcard by using the  button. This is available when this dialog box is opened 
from the Editor panel and "Wild-card" is selected in [Search criteria].

- # Any single digit

- * Zero or more of any character

- ?  Any single character

- [!] Any one character not in the set

- [] Any one character in the set

(4)

(1)

[Function buttons]

(2)

(3)
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You can select the following regular expressions by using the  button. This is available when this dialog box is 
opened from the Editor panel and "Regular Expression" is selected in [Search criteria].

- $ End of line

- ( ) Group capture

- * Zero or more

- + One or more

- . Any single character

- [] Any one character not in the set

- [^] Any one character not in the set

- \ Escape special character

- \b Word boundary

- \n Line break

- \s Whitespace

- ^ Beginning of line

- | Or

Remark For details on regular expressions, see "B.REGULAR EXPRESSIONS SYNTAX".

(2) [Replace with] area
Designate characters to be replaced.
You can directly enter the characters into the text box (maximum characters: 1024) or select from the input history 
in the drop-down list (up to 10 history entries).

(3) [Search location] area
Designate the location to find.
Select either one of the following items from the drop-down list or directly enter the file location from the keyboard 
(maximum number: 10).

Remark Up to 10 history entries are recorded in the drop-down list.

(4) [Option] area
This area is shown when the [Option] button is clicked (not shown by default).
The following options can be designated as search criteria.

(a) [Search criteria]
Select one of the following items from the drop-down list.

Item Operation

Current document (Panel Name) Finds within the current Editor panel.

All open documents Finds within all the opening the Editor panel.
If no file is opened in the Editor panel, this item is disabled.

Active project Finds within the text file included in the active project.
When [File type] is specified, finds only the specified type.
Note that is the current project does not exist, this item is disabled.

Main project and subprojects Finds within the text file included in the main project and subproject.
When [File type] is specified, finds only the specified type.
Note that if the current project does not exist, this item is disabled.

Folder Name Finds within the text file in the folder specified by directly entering (the 
maximum characters: 259) the path (relative path is from the project 
folder), or specified in the Browse For Folder dialog box opened by click-
ing the [...] button in this area.  When folders are not specified, the project 
folder name is shown in "( )" by default folder (if the project does not exist, 
the current user document folder is shown).
When [File type] is specified, searches only the specified type.
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Note This item is enabled only when the Editor panel is focused.

(b) [File type]
Specify File types to search.
Select one of the following items from the drop-down list.

Note Shows extensions of the source file added to the Project Tree panel.

Note that the finds can be operated by limiting the search criteria by directly entering the file name in the text 
box (maximum characters: 1024).
If this is the case, the wildcard "*" can be used and multiple file names can be specified by separating them with 
";".

Caution If you directly enter terms in this text box, they must consist only of wildcards as the filenames 
and filename extensions.
If you enter "Source files(*.c; *.h)", for example, "Source files(aaa.c" and "Source files(bbb.c", 
and "ccc.h)" will be covered by the search, but "aaa.c", "bbb.c", and "ccc.h" (presumably the 
intention) will not. To find "aaa.c", "bbb.c", and "ccc.h", simply enter "*.c; *.h".

Remark Up to 10 history entries are recorded in the drop-down list.

(c) [Match case]

(d) [Match whole word]

(e) [Open file before replacing]

[Function buttons]

Item Operation

Normal Finds the characters designated in [Search text] area.

Wild-card Finds using the wildcard designated in [Search text] area.

Regular ExpressionsNote Finds using the regular expressions designated in [Search text] area.

Item Operation

Source files (ExtensionsNote) Files to find are limited to the source files.

Text files (*.txt) Files to find are limited to the text files.

All files (*.*) Finds all the files.

Finds with the designated characters in case-sensitive.

Finds with the designated characters in not case-sensitive (default).

Finds with a designated exact word.

Finds with at least one of the words (default).

Replace is done after opening the file to find/replace characters in the Editor panel.

Replace is done without opening the file to find/replace characters (default).

Button Function

Option Switches between display/hide the [Option] area in this tab.

Replace All Finds characters with designated criteria in batch and replaces the searched 
characters to the one designated to be replaced.

Cancel Ignores the setting and closes this dialog box.
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Help Displays the help of this dialog box.

Button Function
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This dialog box is used to move the caret to a specified line number, symbol, or address. 

Figure A.13 Go to Line Dialog Box

This section describes the following. 

- [How to open]

- [Description of each area]

- [Function buttons]

[How to open]

- Focus the Editor panel, and then select [Go to...] from the [Edit] menu.

- On the Editor panel, select [Go to...] from the context menu. 

[Description of each area]

(1) [Line number (valid line range) or symbol] area
Directly enter the line number (decimal number), symbol nameNote 1 or addressNote 2 to which you want to move 
the caret.
"(valid line range)" shows the range of valid lines in the current file.
By default, the number of the line where the caret is currently located in the Editor panel is displayed.

Note 1. Note the following, when specifying a symbol name:

- Either a function name or a variable name can be specified as a symbol name. 

- On the Property panel of the build tool to be used, specify [Yes(-Xcref)][CC-RH][CC-RX]/[Yes(-
cref)][CC-RL] with the [Output cross reference information] property, and then run and complete 
a build. 

- If an error in building occurs, the cross reference information before the error occurred is used.

Note 2. Note the following, when specifying an address:

- Enter a hexadecimal number with prefix "0x" or "0X" added (a decimal number is handled as a 
line number).

- Run and complete a build. 

- If an error in building occurs, the information before the error occurred is used.

[Function buttons]

Go to Line dialog box

Button Function

OK Places the caret at the start of the specified source line.

Cancel Cancels the jump and closes this dialog box. 

Help Displays the help for this dialog box. 

(1)

[Function buttons]
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This dialog box is used to select a function to be jumped if there are some functions with the same names when a pro-
gram jumps to the function specified on the Editor panel. 

Caution 1. This dialog box is displayed only when there are some functions with the same names and also [Yes(-
Xcref)][CC-RH][CC-RX]/[Yes(-cref)][CC-RL] is specified with the [Output cross reference information] 
property on the Property panel of the build tool to be used.

Caution 2. This dialog box targets only files that have been registered in the project.

Figure A.14 Jump to Function Dialog Box

This section describes the following. 

- [How to open]

- [Description of each area]

- [Function buttons]

[How to open]

- On the Editor panel, select [Jump to Function or Variable] from the context menu. 

[Description of each area]

(1) Candidates in the jump destination display area
This area displays a list of candidates in the jump destination.
Candidates are displayed in the alphabetical order of the names of [File].  If candidates are included in the same 
file, they are displayed in the order of line numbers.

(a)  [File Name]
Displays the name of the file (without any path) in which the function is defined.

(b) [Line Number]
Displays the number of the line to which the function is defined. 

(c)  [Path]
Displays the path of the file in which the function is defined. 

[Function buttons]

Jump to Function dialog box

Button Function

OK  Jumps to the line that defines the target function after selecting the line in Candidates in the 
jump destination display area and clicking this button.

Cancel Cancels the jump and closes this dialog box. 

Help Displays the help for this dialog box. 

(1)

[Function buttons]
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This dialog box is used to display the position where a bookmark is to be set or to delete a bookmark.

Figure A.15 Bookmarks Dialog Box

The following items are explained here. 

- [How to open]

- [Description of each area]

- [Function buttons]

[How to open]

- Click the  button on the bookmark toolbar.

- From the [Edit] menu, select [Bookmark] >> [List Bookmarks...].

- On the Editor panel, select [Bookmark] >> [List Bookmarks...] from the context menu.

[Description of each area]

(1) Bookmark list area
This area displays a list of bookmarks that have been registered.
The bookmarks are listed alphabetically by file name for [Bookmark].  Bookmarks in the same file are listed in line 
number order.
When a bookmark is added to the Editor panel, a bookmark function is added.
In the bookmark list area, double-clicking on a line moves a caret to the corresponding position for the bookmark.

(a) [File]
Displays the name of the file (without any path) in which a bookmark is registered.

(b) [Line Number]
Displays the number of the line to which the bookmark is registered.

(c) [Path]
Displays the path of the file in which the bookmark is registered.

(d) Buttons

Bookmarks dialog box

View Moves a caret to the selected position for the bookmark.
However, this button is disabled when no bookmark is selected, two or more bookmarks 
are selected, or no bookmark is registered.

Remove Removes a selected bookmark.  When two or more bookmarks are selected, all of those 
selected are removed.
However, this button is disabled when no bookmark is selected or no bookmark is regis-
tered.

Remove All Removes all the registered bookmarks.
This button is disabled when no bookmark is registered.

(1)

[Function buttons]
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Caution Registered bookmarks are not deleted even if the Editor panel is closed.
Note, however, that if the Editor panel in which a file that has never been saved is being dis-
played is closed, then registered bookmarks will be deleted.

[Function buttons]

Button Function

Previous Moves a caret to the position of the bookmark previous to the selected bookmark.
This button is disabled in the following cases.

- A bookmark shown in the first line has been selected.

- No bookmark is selected.

- Two or more bookmarks are selected.

- No bookmark is registered.

- Only one bookmark is registered.

Next Moves a caret to the position of the bookmark next to the selected bookmark.
This button is disabled in the following cases.

- A bookmark shown in the last line has been selected.

- No bookmark is selected.

- Two or more bookmarks are selected.

- No bookmark is registered.

- Only one bookmark is registered.

Close Closes this dialog box.

Help Displays the help for this dialog box.
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This window is used to preview the file currently being displayed in the Editor panel before printing.

Figure A.16 Print Preview Window

Remark This panel can be zoomed in and out by moving the mouse wheel forward or backward while holding 
down the [Ctrl] key.

The following items are explained here.

- [How to open]

- [Description of each area]

- [Toolbar]

- [Context menu]

[How to open]

- Focus the Editor panel, and then select [Print Preview] from the [File] menu.

[Description of each area]

(1) Preview area
This window displays a form showing a preview of how and what is printed.
The file name (fully qualified path) and the page number are displayed at the page header and page footer.
The display differs according to whether the debug tool is or is not connected, and when it is connected, to 
whether the display is in normal display mode or mixed display mode.  Note, however, that columns that are hid-
den on the Editor panel are not displayed (these columns are not printed).

Print Preview window

(1)

[Toolbar]
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[Toolbar]

[Context menu]

Opens the Print dialog box provided by Windows to print the current Editor panel as shown by the print pre-
view form.

This button is always disabled.

Increases the size of the content.

Decreases the size of the content.

Displays the preview at 100-percent zoom (default).

Fits the preview to the width of this window.

Displays the whole page.

Displays facing pages.

Increase Zoom Increases the size of the content.

Decrease Zoom Decreases the size of the content.
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B.  REGULAR EXPRESSIONS SYNTAX

This section provides detailed explanations of the regular expressions used for the Find and Replace dialog box.
The regular expressions supported in CS+ are based on the Microsoft .NET regular expressions syntax.

Remark Whitespace characters are ignored in all regular expression strings.  Whitespace characters can be 
specified in the search string by using the \s character. 

B.1  Character Escapes

The following table describes the escape characters and sequences that can be used in regular expressions:

Table B.1 List of Character Escapes

B.2  Character Classes

The following table describes character matching syntax:

Table B.2 List of Character Classes

Escaped Character Description

(Ordinary characters) Characters other than . $ ^ { [ ( | ) * + ? \ match themselves.

\a Matches a bell (alarm) \u0007.

\t Matches a tab \u0009.

\r Matches a carriage return \u000D.

\v Matches a vertical tab \u000B.

\f Matches a form feed \u000C.

\n Matches a new line \u000A.

\e Matches an escape \u001B.

\040 Matches an ASCII character as octal (exactly three digits). The character \040 represents a 
space.

\x20 Matches an ASCII character using hexadecimal representation (exactly two digits).

\u0020 Matches a Unicode character using hexadecimal representation (exactly four digits).

\ When followed by a character that is not recognized as an escaped character, matches that 
character. For example, \* is the same as \x2A.

Character Class Description

. Matches any character except \n. When within a character class, the . will be treated as a 
period character.

[aeiou] Matches any single character in the specified set of characters.

[^aeiou] Matches any single character not in the specified set of characters.

[0-9a-fA-F] Use of a hyphen (-) allows specification of contiguous character ranges.

\p{name} Matches any character in the Unicode general category specified by name (for example, Ll, 
Nd, Z).
See the "B.3Supported Unicode General Categories", for details on the Unicode general 
category. 

\w Matches any word character, which includes letters, digits, and underscores.

\W Matches any non-word character.
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B.3  Supported Unicode General Categories

The following table describes the supported Unicode general categories. These categories can be used with the \p and 
\P character classes. See the "B.2Character Classes", for details on the character classes.

Table B.3 List of Supported Unicode General Categories

\s Matches any whitespace character.

\S Matches any non-whitespace character.

\d Matches any decimal digit.

\D Matches any non-digit.

[.\w\s] Escaped built-in character classes such as \w and \s may be used in a character class. 
This example matches any period, word or whitespace character.

Unicode General Categories Description

Lu Letter, Uppercase

Ll Letter, Lowercase

Lt Letter, Titlecase

Lm Letter, Modifier

Lo Letter, Other

Mn Mark, Nonspacing

Mc Mark, Spacing Combining

Me Mark, Enclosing

Nd Number, Decimal Digit

Nl Number, Letter

No Number, Other

Pc Punctuation, Connector

Pd Punctuation, Dash

Ps Punctuation, Open

Pe Punctuation, Close

Pi Punctuation, Initial quote

Pf Punctuation, Final quote

Po Punctuation, Other

Sm Symbol, Math

Sc Symbol, Currency

Sk Symbol, Modifier

So Symbol, Other

Zs Separator, Space

Zl Separator, Line

Character Class Description
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Additional special categories are supported that represent a set of Unicode character categories, as shown in the follow-
ing table:

Table B.4 List of Set of Unicode Character Categories

B.4  Quantifiers

Quantifiers add optional quantity data to a regular expression. A quantifier expression applies to the character, group, or 
character class that immediately precedes it.

The following table describes the metacharacters that affect matching quantity:

Table B.5 List of Quantifiers

B.5  Atomic Zero-Width Assertions

The following table describes the atomic zero-width assertions. The metacharacters described in the following table do 
not cause the engine to advance through the string or consume characters. They simply cause a match to succeed or fail 
depending on the current position in the string. 

Zp Separator, Paragraph

Cc Other, Control

Cf Other, Format

Cs Other, Surrogate

Co Other, Private Use

Cn Other, Not Assigned

Category Description

C (All control characters) Cc, Cf, Cs, Co, and Cn.

L (All letters) Lu, Ll, Lt, Lm, and Lo.

M (All diacritic marks) Mm, Mc, and Me.

N (All numbers) Nd, Nl, and No.

P (All punctuation) Pc, Pd, Ps, Pe, Pi, Pf and Po.

S (All symbols) Sm, Sc, Sk, and So.

Z (All separators) Zs, Zl, and Zp.

Quantifier Description

* Specifies zero or more matches; for example, \w* or (abc)*. Same as {0,}.

+ Specifies one or more matches; for example, \w+ or (abc)+. Same as {1,}.

? Specifies zero or one matches; for example, \w? or (abc)?. Same as {0,1}.

{n} Specifies exactly n matches; for example, (pizza){2}.

{n,} Specifies at least n matches; for example, (abc){2,}.

{n,m} Specifies at least n, but no more than m, matches.

Unicode General Categories Description
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Table B.6 List of Atomic Zero-Width Assertions

B.6  Grouping Constructs

The following table describes the grouping constructs. Grouping constructs allow you to capture groups of sub-expres-
sions and to increase the efficiency of regular expressions with non-capturing look ahead and look behind modifiers.

Table B.7 List of Grouping Constructs

B.7  Substitutions

Substitutions are allowed only within find/replace replacement patterns.
Character escapes and substitutions are the only special constructs recognized in a replacement pattern.
 The following table shows how to define named and numbered replacement patterns:

Table B.8 List of Substitutions

Assertion Description

^ Specifies that the match must occur at the beginning of the document or the beginning of the line.
For example, ^#region returns only those occurrences of the character string #region that occur at 
the beginning of a line. 

$ Specifies that the match must occur at the end of the string, before \n at the end of the string, or at 
the end of the line.

\A Specifies that the match must occur at the beginning of the document.

\z Specifies that the match must occur at the end of the document.

\b Specifies that the match must occur on a boundary between \w (alphanumeric) and \W (nonalpha-
numeric) characters.

\B Specifies that the match must not occur on a \b boundary.

Grouping Constructs Description

( ) Captures the matched substring if used in a find and replace operation.

(?=) Zero-width positive look ahead assertion. Continues match only if the sub-expression 
matches at this position on the right. For example, (_?=\w) matches an underscore fol-
lowed by a word character without matching the word character.

(?!) Zero-width negative look ahead assertion. Continues match only if the sub-expression 
matches at this position on the right. For example, \b(?!un)\w+\b matches words that 
do not begin with un.

(?<=) Zero-width positive look behind assertion. Continues match only if the sub-expression 
matches the position on the left. For example, (?<=19)99 matches instances of 99 that 
follow 19.

(?<!) Zero width negative look behind assertion. Continues match only if the sub-expression 
does not match this position on the left.

Character Description

$1 Substitutes the last substring matched by group number 1 (decimal). The second group is number 2 
($2), and so on.
For example, the replacement pattern a*$1b inserts the string a* followed by the substring matched 
by the first capturing group, if any, followed by the string b.

$0 Substitutes a copy of the entire match itself.

$& Substitutes a copy of the entire match itself.

$$ Substitutes a single $ literal.
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Remark 1. The * character is not recognized as a metacharacter within a replacement pattern.

Remark 2. $ patterns are not recognized within regular expression matching patterns. Within regular expressions, $ 
designates the end of the string.

B.8  Other Constructs

The following table describes other regular expression constructs:

Table B.9 List of Other Constructs

Constructs Description

" " Encapsulates a fixed string of characters.

{ } Provides a call to a lexical macro. The use of a WordMacro (which is similar to \w) would appear as 
{WordMacro}.

(?# ) Inline comment inserted within a regular expression. The comment terminates at the first closing 
parenthesis character.

| Provides an alternation construct that matches any one of the terms separated by the | (vertical bar) 
character. For example, cat|dog|tiger. The left most successful match wins.
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